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Picarro Analyzer User Manual 

Thank you for purchasing a Picarro product. Your Picarro system is a quality product 

that has been designed and manufactured to provide reliable performance. 

This User Manual (UM) is an important part of your purchase as it will help familiarize 

you with the system and explain the numerous features that have been designed 

into it. Please read this manual thoroughly before using your Picarro system. 

Please contact Picarro or your authorized Picarro distributor should you have questions 

regarding specific applications or if you require additional information. 

NOTICES 

DISCLAIMER AND RESERVATION OF RIGHTS 

Picarro has prepared this manual solely for the information and use by its customers as 

a guide for the selection, installation, operation, and maintenance of the products 

described. 

EXCEPT AS PROVIDED IN THE TERMS AND CONDITIONS OF SALE FOR PICARRO 

PRODUCTS, PICARRO ASSUMES NO LIABILITY WHATSOEVER, AND PICARRO 

DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY, RELATING TO SALE OR USE 

OF PICARRO PRODUCTS, INCLUDING LIABILITY OR WARRANTIES RELATING TO 

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

Picarro reserves the right to change or update the contents of this manual and the 

specifications of its products at any time, without notice. Picarro has endeavored to 

include information that is current and accurate as of the date of the publication or 

revision of this document, but Picarro does not guarantee that this document is error free 

or that it is accurate with regard to any particular specification. 

Picarro expressly reserves all intellectual property rights, including all intellectual 

property rights relating to any product described in this manual. This document does not 

grant any license, express or implied, by estoppel or otherwise, to any intellectual 

property rights of Picarro or any third party. 

PATENTS 

The products described in this manual are subject to Picarro patents and patents 

pending. Information about Picarro patents applicable to these products is available at 

www.picarro.com/company/patents 

TRADEMARKS 

Picarro and the Picarro logo are trademarks of Picarro, Inc. 

Windows® is a trademark of Microsoft Corporation 

Swagelok® is a trademark of Swagelok Company 

Copyright © 2020 Picarro, Inc. All rights reserved  

https://www.picarro.com/company/patents
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Contact Information 

General Technical Support: 

Email:               support@picarro.com  

Phone:             +1 408 962 3991 

 

European Technical Center: 

Email:               support@picarro.com 

Phone:              +31 85 888 1650 

 

Customer Service: 

Email:               orders@picarro.com 

Phone:             +1 408 962 3992 
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1. INTRODUCTION TO TECHNOLOGY 
Picarro analyzers use time-based, optical absorption spectroscopy of the target 

gases to determine concentration in a sample. They are based on wavelength-

scanned cavity ring-down spectroscopy (WS-CRDS), a technology in which light 

travels many times through the sample, creating a very long effective path length 

for the light to interact with the target gas, thus enabling excellent detection 

sensitivity in a compact and rugged instrument.  

The Picarro analyzer is comprised of two modules: 

• The Analyzer contains the spectrometer, sample chamber, and a 
computer with a hard drive to store and analyze data. The single 
analyzer module controls the operation of the system and converts 
spectroscopic measurements into gas concentration data. 

• The External Vacuum Pump draws the sample gas through the 
instrument. 

1.1 Cavity Ring-Down Spectroscopy (CRDS) 

Nearly every small gas-phase molecule (e.g., CO2, H2O, H2S, NH3) and 

isotopologue (e.g., H2
18O, 13CO2, 15N14N16O) uniquely absorb specific 

wavelengths of near-infrared light. The strength of the light absorption is 

related to the concentration of a molecule in a sample and the distance that 

light travels through the sample, called the path length.  

Conventional infrared spectrometers are typically only sensitive enough to 

detect trace gases at levels in the part-per-million. Cavity Ring-Down 

Spectroscopy (CRDS), on the other hand, is one thousand to one million 

more times sensitive.  

The increased sensitivity of CRDS is due to the design of the sample cavity 

and the time-based measurement. In the cavity, a series of mirrors reflects 

the infrared light through the sample, increasing the path length. For a 

Picarro cavity of only 25 cm in length, the effective path length of the cavity 

can be over 20 kilometers.  

In Picarro analyzers, light from a single-frequency laser enters a cavity 

where three mirrors reflect the laser light as seen in Figure 1. The light 

enters through the mirror closest to the laser, bounces off the angled mirror 

in the lower right corner of the cavity, travels to the hemispherical mirror at 

the top of the cavity, bounces toward the mirror in the lower left corner of 

the cavity, and then returns to the first mirror. This motion becomes a 
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continuous traveling light wave, which is represented by the dark orange 

path in Figure 1. 

Figure 1: 
Schematic of 

the Picarro 
CRDS analyzer 

cavity 

  

When the laser is on, the cavity quickly fills with laser light. A small amount 

of the laser light is transmitted through the mirror closest to the 

photodetector, which turns the incident light into a signal that is directly 

proportional to the light intensity in the cavity. 

When the photodetector signal reaches a threshold level (in a few tens of 

microseconds), the laser is turned off. The light contained within the cavity 

continues to bounce between the mirrors (about 40,000 times). Since the 

mirrors have slightly less than 100% reflectivity (99.999%), the light inside 

the cavity steadily leaks out of the cavity. The intensity of the light reaching 

the detector decreases, falling exponentially until it reaches zero. This 

decay, or "ring-down,” is measured in real time by the photodetector. 

1.2  Relating ring-down time to absorption intensity 

The time it takes to ring-down is inversely related to the total optical loss in 

the cavity, including the strength of molecular absorption at a given 

wavelength of light. For an empty cavity, the time it takes for the intensity to 

decrease by a given percent is determined solely by the reflectivity of the 

mirrors. A cavity containing gas that absorbs light will have a shorter ring-

down time than an empty cavity. As the light circulates in a cavity with a 

gas sample, the molecular absorption by the gas results in a decrease of 

the light intensity. 
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Determining absorption intensity at a specific wavelength requires 

comparing the ring-down time of an empty cavity to the ring-down time of a 

cavity that contains gas. A cavity can be empty if it contains no gas; it will 

also appear empty if the molecules of the sample inside the cavity do not 

interact with the specific wavelength of light.  

Picarro instruments gather measurements from an “empty” cavity by 

switching the light to wavelengths that are not absorbed by the target 

molecules. The analyzer subsequently measures ring-down times at 

wavelengths that are absorbed by the target gas. The analyzer 

automatically and continuously compares these two types of ring-down 

times, and the software uses those comparisons to calculate absorption 

intensities. 

Figure 2: 
Light intensity 

as a function of 
time in a CRDS 

system 

  

1.3  Converting absorption intensity to concentration 

Plotting the absorbance at each measured wavelength generates an 

optical spectrum. This spectrum contains absorbance peaks that are 

unique to each molecule in the sample. The height of a particular 

absorption peak is proportional to the concentration of a molecule that 

generated the signal.  

The height of the peak is calculated by subtracting the maximal 

absorbance from the baseline absorbance. Figure 3 shows a plot of ideal 
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optical spectra with a clean, uniform baseline on either side of the 

absorption peak. 

Figure 3: 
Absorption 

Spectral Curve 

  

However, optical spectra often contain several absorption lines, nested 

closely together. A particular absorption peak may be visible between lines, 

but the absorption may not return to the baseline before it rises in response 

to another molecule.  

Picarro analyzers calculate the baseline underneath a poorly resolved peak 

by modeling the absorption peaks from other surrounding molecules and 

subtracting contributions from neighboring peaks to the absorption 

intensity.  

1.4 Spectral precision and high sensitivity measurements 

Picarro analyzers contain two features that provide high spectral precision:  

• A proprietary wavelength monitor (WLM) that measures the absolute 
laser wavelength to a precision that is a few orders of magnitude 
narrower than the spectral linewidth: Picarro’s patented WLM measures 
absolute laser wavelength to a precision more than 1,000 times 
narrower than the observed Doppler-broadened linewidth for small gas-
phase molecules. The instruments lock the laser to the WLM, and then 
the monitor tunes to wavelengths known to be maximally and minimally 
absorbed by the target molecule. The result is closely clustered 
absorption intensities, measured at wavelengths just before peak 
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absorption, at peak absorption, and just after peak absorption, as the 
absorbance returns to the baseline.  

• Precise temperature and pressure control in the sample cavity: 
Accurate absorption measurements at precisely known wavelengths 
account for little unless the temperature and pressure of the CRDS 
measurement cavity are known. The observed line intensity and shape 
depend on the temperature and pressure inside the sample cavity. 
Small temperature and pressure instabilities can result in large 
concentration errors due to fluctuating peak heights and baselines. To 
completely minimize instrument measurement drift, temperature and 
pressure must be actively stabilized to constant values.  

For precise temperature control, the sample cavity is surrounded by layers 

of thermally insulating material to provide a high degree of passive thermal 

stability. The cavity is further actively stabilized by means of a solid-state 

heating system locked to the output of a thermal sensor. This enables the 

temperature of the cavity to be within 20 mK of the set temperature.  

For precise pressure control, the cavity pressure is monitored using a high-

linearity pressure transducer. The system computer uses this pressure 

data in a feedback loop to control proportional valves that adjust the inlet 

and outlet gas flow of the cavity.  
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2. CONVENTIONS 
The following icons are used throughout this manual to emphasize important 

information in the text. These icons indicate dangers to either the operator or to the 

analyzer, and other important information. 

 

Consult the user’s manual for important information 

(When you see this symbol placed at hazard points 

on equipment, consult the user manual). 

 

NOTE is important information that you should be 

aware of before proceeding. 

 
WARNING 

LASER WARNING alerts you of a laser danger. 

 
CAUTION 

CAUTION alerts you of a potential danger to 

equipment or to the user. 

 
WARNING 

WARNING indicates an imminent danger to the 

user. 

 
REMINDER 

REMINDER is a helpful hint to procedures listed in 

the text. 
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3. ACRONYMS 
This manual includes various acronyms. For definitions, see below:  

Acronym Definition 

CRDS Cavity Ring-Down Spectroscopy  

DAS Data Acquisition System (the Analyzer) 

PPU Pump Power Unit 

GUI Graphical User Interface  

cm centimeters  

mm millimeters  

” (as in 1/4”) Inches 

N2O Nitrous Oxide  

CO Carbon Monoxide 

H2O Water  

HB Hotbox  

WB Warm box  

ppm Parts Per Million  

ppb Parts Per Billion  

‰ per mil  

°C degrees Celsius  
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4. SAFETY 

4.1 General Safety 

CDRH Certification 

This Picarro Analyzer complies with 21 CFR Chapter 1, sub-chapter J, and 

is classified as a Class 1 laser system when all panels and covers are on. 

CE Certification 

This Picarro Analyzer complies with the European standards and the 

instrument is affixed with a CE label. This CE label is located on the rear of 

the instrument. 

 

 
WARNING 

Using this analyzer in a manner not specified by Picarro may result 

in damage to the analyzer and render it unsafe to operate. 

 

 
WARNING 

is analyzer is for indoor use only and has an ingress protection 

rating of IPx-0. Analyzer is NOT protected against exposure to 

water including dripping, spraying, splashing or immersion. 

 

 
WARNING 

Do not operate in an explosive atmosphere! Do not operate in the 

presence of flammable gases or fumes.  

 

 
CAUTION 

The analyzer contains no user serviceable components except the 

particulate filter, fuse, and laser chiller. Do not attempt repairs; 

instead, report all problems to Picarro Customer Service or your 

local distributor. Please contact Picarro if you have any questions 

regarding the safe operation of this equipment. 

 

 
WARNING 

The inlet gas connector on the back panel of the Analyzer, and its 

immediate vicinity, runs hot during operation of the analyzer. Take 

care when connecting gas lines or working at the rear of the 

instrument to wear protective gloves or avoid contact with these 

surfaces. 
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WARNING 

This analyzer weighs 67 lbs. (30.4 kg). Use the technique described 

below when lifting the analyzer. 

a. Before lifting, inspect the unit for slippery substances or sharp 

edges. 

b. Lift with two people, one on each side of the analyzer. 

c. Crouch down and stay close to the unit. Always keep your 

back as straight as possible.  

d. Position your feet for sturdy balance. Lift with your legs, not 

your back.  

e. Do not twist the back while carrying the unit. Rotate direction 

with hip joints.  

f. Lower the unit by bending at the knees.  

4.2 Laser Safety 

 
WARNING 

This equipment is classified as a Class 1 laser product with an 

embedded 3B laser in accordance with EN 60825-1:2014. Do not to 

open the enclosure where this label is placed; there are no user 

serviceable parts inside. 

 
The following Laser Safety Label is affixed to the outer cover of the 
analyzer. 
 

 

 

 
WARNING 

The laser is a Class3B when exposed.  

Only operate or service this device in accordance with the 

instructions in this guide, and only open the device in an approved 

laser safe service area using appropriate laser-safety glasses. 

 

The following Laser Safety Label is affixed to the inside of the analyzer:  
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Figure 4: 
Laser Safety 

Label 

 

 

 
WARNING 

Use of controls or adjustments or performance of procedures other 

than those specified herein may result in hazardous radiation 

exposure. 
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5. UNPACKING THE ANALYZER 

5.1 Inspect the Shipping Boxes 

Picarro products are inspected and tested before leaving the factory. Their 

packing containers have been designed to keep the equipment safe from 

damage during transit. 

Inspect the condition of the boxes upon arrival. The system is delivered in 

a shipping crate divided into two sections: if the outer box shows damage, 

the inner area holding the analyzer is cushioned enough that it will protect 

the instrument under most circumstances. 

 
NOTE 

If the equipment appears to be damaged, photograph the damages 

and contact Picarro (email pictures if possible) as soon as 

possible. 

The analyzer section contains: 

• Analyzer 

• Keyboard 

• Mouse 

The pump section contains: 

• Vacuum pump  

• Cables and hoses needed to connect and power the analyzer and 

pump 

Figure 4: 
Shipping Crate 

and Contents 
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5.2 Unpack the Shipping Crate 

This section describes the contents of the shipping crate: 

• Inspect each item to ensure it is not damaged.  

• If items are missing, contact Picarro. 

• Keep the shipping crate and all packaging to reuse when transporting 

the analyzer. 

• Contact Picarro for options on transporting systems to remote labs. 

 
WARNING 

This analyzer weighs 67 lbs. (30.4 kg). Use the technique outlined in the 

General Safety section on page 15 when lifting or moving the analyzer.  

 

Figure 5: 
Analyzer and 

Pump 
Components 

 

 

Figure 6: 
Connection 

Componentts 

 

Analyzer 

Pump 

USB Port 

Power 

Indicator 

Soft On/Off 

Pump Power 

indicator 
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Analyzer, Pump, and Connection Components 

Item (qty) Description 

Analyzer (1) Includes all the data acquisition, control, 

and communications hardware and 

firmware to perform all gas handling, 

spectral collection and analysis. 

Pump (1) Provides vacuum required for sample gas 

sequencing into and out of the analyzer. 

Vacuum Hose (1) Hose to connect the pump to the analyzer. 

A/C Power  

Cables (2) 

A power cable with connectors appropriate 

to your region is provided. The analyzer 

automatically adjusts to local voltage. 

Keyboard (1) USB keyboard 

Mouse (1) USB mouse 

Multi-Pin Control 

Cable (1) 

For External Solenoid Valves  

Electronic cable (25-pin) 

Nut (1) and  

Ferrules (2) 

For connecting input line to analyzer 

INPUT 

Document Packet (1) Includes this manual, certificate of 

compliance, and Windows License. 

USB Flash Drive  Contains backup software. 

Unpacking the Pump Unit 

1. Unpack the pump unit from the crate and plastic bag and place it on 
a tabletop. 

2. Remove the two screws from the black plate on the base of the PPU 
and remove the plate. This plate keeps the rubber feet on the pump 
(inside the PPU enclosure) from shearing off. Removing the screws 
releases the pump inside the PPU, allowing it to vibrate freely. See 
Figure 8. 
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Figure 7: 
Removing the 

Pump Securing 
Screws 

 

 

 
NOTE 

Save the plate with the packing materials (crate, shipping foam, 

plastic bags and desiccation pouches). Re-attach the plate before 

packing and shipping the unit. 

3. Unpack the analyzer and remove it from its plastic bag. 

4. Carefully set the analyzer atop the PPU to prepare for setup of 
connections at the back. Figure 6 above shows the analzyer 
positioned correctly on the PPU. 

 
CAUTION 

Leave enough free space for ease in making connections. Leave 6” 

free space at the rear of the analyzer and 6” free space at the front 

of the analyzer. 
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6. ANALYZER OVERVIEW 

6.1 Intended Use 

The G5131-i analyzer measures concentrations of Isotopic N2O 

(18O and 15N) using Picarro’s patented Cavity Ring-Down Spectroscopy 

(CRDS). The analyzer can be deployed for air monitoring applications in a 

lab or in the field, allowing in-situ analysis of trace and ambient amounts of 

Isotopic N2O. 

6.2 External Vacuum Pump 

The external vacuum pump is used to maintain cavity pressure inside the 

analyzer. The pump should be connected and running whenever the 

analyzer is in use. 

6.3 Analyzer Specifications 

Weight (Total) 

Analyzer 

Pump 

87 lbs. (39.5 kg), Including external pump 

67 lbs. (30.4 kg) 

20 lbs. (9.1 kg) 

Analyzer Dimensions 17” W x 12” H x 27” D (43 x 32 x 69 cm) 

Temperature Range 15 to 35°C (operating) -10 °C to 50 °C (storage) 

Sample Pressure 300 to 1000 Torr (40 to 133 kPa) 

Sample Flow Rate < 50 sccm at 760 Torr (101 kPa) 

Ambient Humidity Range  < 85% R.H. non-condensing 

Maximum Altitude 10,000 ft. (operation) 

Clearance Front: 6" (15.3 cm); Rear: 6" (15.3 cm) 

Power Requirements 

Startup Power 

Steady-state Power 

Mains Supply Voltage 

Fluctuation 

100 to 240 VAC; 47 to 63 Hz (auto-sensing) 

<375 W at start-up (Analyzer and Pump) 

120 W (Analyzer), 150 W (Pump) Steady-state 

operation 

±10% of the nominal voltage 

Minimum Rated Circuit 

Amperage 

10 A @115 VAC,  

5 A @230 VAC 

Liquid Ingress Protection None 
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6.4 Analyzer Operation Flow Diagram 

To measure discrete samples (such as individual gas bags) or from 

multiple locations (when switching valves draw in ambient air from different 

heights), a separate software window (coordinator) is used to control the 

sample source and match the corresponding real time read out with the 

sample source. Depending on system configuration, coordinator programs 

may not be included. Figure 9 shows analyzer operation as a flow diagram. 

Figure 8: 
Analyzer 

Operation Flow 
Diagram 

 

1. The samples A, B, and C are introduced into the analyzer 
sequentially. 

2. The timing of sample introduction is controlled by coordinator or 
valve sequencer software. 

3. The analyzer measures samples continuously and reports the data 
to the GUI. 

4. The GUI saves a single file where all data is reported as a function 
of time. The coordinator gets data from the GUI and creates a single 
file, the data is reported as a function of sample. 

5. Before shutdown, Picarro recommends flowing clean dry air (CDA) 
through the analyzer for several minutes. This prevents moist gas in 
the cavity from condensing on the optics as the analyzer cools.  
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7. INSTALLATION 
This section describes the setup and installation of the Picarro Analyzer. Please 

read and understand this section thoroughly before proceeding with the 

installation. 

 
WARNING 

Using this analyzer in a manner not specified by Picarro may result 

in damage to the analyzer and render it unsafe to operate. 

 

 
WARNING 

Do not attach electrical power to or start the analyzer until after 

attaching and turning on the External Vacuum Pump. Do not 

disconnect the vacuum line while the analyzer is running. Failure to 

do so could result in damage to the optics. 

 

 
WARNING 

Picarro sells USB enabled devices, such as GPS, which is 

approved for use. Please do not connect USB hubs or unapproved 

USB devices, other than flash drives to the computer because they 

can interfere with the operation of the analyzer. 

 

 
WARNING 

If rack mounted, the Analyzer cannot support itself using a front 

rack mount kit alone. The instrument must be supported by a shelf 

or additional rails attached to the rack. 

 

 
CAUTION 

If the analyzer has been stored at less than 10 °C, allow the 

components to equalize to room temperature before starting the 

installation process. 

 

 
WARNING 

Analyzer is for indoor use only and has an ingress protection rating 

of IPx-0. Analyzer is NOT protected against exposure to water 

including dripping, spraying, splashing or immersion. Do not 

operate or store the unit outside or exposed to the elements. 

 



 

24 P/N 40-0008 Rev. D G5131-i User Manual 

 

CAUTION 

When the analyzer is being integrated to an external system, the 

safety of that system is the responsibility of the assembler of that 

system.  

 

 

CAUTION 

During installation and operation, do not position the analyzer so 

that it is difficult to operate the disconnecting device.  

 

 
NOTE 

Take care to ensure that warm air is exhausted from an enclosure 

in which the analyzer is mounted. 

 

 
CAUTION 

It is imperative that the analyzer have adequate ventilation and/or 

cooling to maintain the ambient temperature below 35 °C when 

operating. Failure to provide adequate airflow, especially clearance at 

the front and rear panels, to ensure proper airflow and/or cooling to the 

analyzer will result in overheating of the analyzer causing a shutdown 

and potential damage. There should be 4” (10cm) of clearance in the 

front and back of the analyzer. 

 

7.1 Analyzer and Vacuum Positioning 

1. Remove the Analyzer and Vacuum Pump from the shipping 
container. This requires two persons for lifting the hardware. 

 
WARNING 

This analyzer weighs 67 lbs. (30.4 kg). Use the technique outlined in the 

General Safety section on page 15 when lifting or moving the analyzer.  
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2. Place the Pump unit on a bench top or flat surface. Place the 
analyzer on top of the pump. Don’t push the analyzer/pump into 
position yet; there are cables to be installed on the back panel. 

Figure 9: 
Analyzer and 

Pump 
Placement 

 

3. Unpack the analyzer connection accessories. The Certificate of 
Compliance and USB drive should be stored in a safe place and 
may be required if you contact Picarro with questions about the 
analyzer. 

7.2 Connections 

Figure 11 shows the analyzer rear panel with the connections labeled. The 

numbered steps in below correspond to the numbered list below. 
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Figure 10: 
Rear panel 

connections 

 

1. Connect the vacuum hose to the top box. 

2. Connect the free end of the vacuum hose to the bottom box. 

 
WARNING 

Equipment Damage: Never disconnect the vacuum hose unless the 

pump and analyzer are OFF, otherwise the system may be 

damaged. 

3. Connect the inlet from the analyzer to the sample line. 

4. Connect the 25-pin cable to the analyzer. 

5. Connect the 25-pin cable to the bottom box. 

6. Leave the exhaust port open to the atmosphere. 

 
CAUTION 

Use the AC power cables supplied with the analyzer or a similarly 

rated cable. Check with Picarro technical support if you have 

questions about power cable replacement. An inadequately rated 

power cable can result in equipment damage. 
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CAUTION 

Cords shall be RATED for the maximum current for the equipment 

and the cable used shall meet the requirements of IEC 60227 or IEC 

60245. Cords certified or approved by a recognized testing 

authority are regarded as meeting this requirement. The connector 

type used should be: IEC320 C13. 

7. Connect power cord to the top box. 

8. Connect the power cord to the bottom box. 

9. Make sure the 110/220 SELECT switch on the bottom box is 
configured properly for your region. 

10. Connect a keyboard (included), mouse (included), and monitor (not 
included) to the computer connectors on the top box. 

 
NOTE 

This device will operate under its default settings without any direct 

control of the internal software. 

11. This switch is used for customers who may want to use external 
pumps.  

When the switch is in the ON position, the internal vacuum pump 
activated.  

When the switch is in the OFF position, the internal vacuum pump 
will remain off even when the analyzer is turned on. 

 
NOTE 

The software to operate the instrument will start automatically after 

the operating system has loaded. The user interface will appear a 

few seconds after the instrument software starts. See “Startup 

Procedure” in Section 8.1. 

7.3 Connecting to the Analyzer Inlet 

Connect to the inlet of the analyzer using ¼" OD PTFE or PFA tubing using 

the supplied plastic ¼" PFA inlet nut and ferrules. 

 
WARNING 

When using compressed gases, follow all appropriate safety 

conventions, including use of eye protection, physical restraint of 

cylinders, etc. 

Making a New Connection: 

When using new tubing, follow these steps. 
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1. Place the two ferrules inside the nut as shown. 

Figure 11: 
Orientation of 

ferrules and nut  

 

2. Loosely connect the nut to the INLET on the back panel of the 
analyzer about a full turn, being careful not to let the ferrules fall out. 

3. Insert the tubing into the back of the nut, feeding it in as far as 
possible without deforming the tubing. 

4. Hand tighten the nut. 

5. Using a 5/8" wrench (not included), tighten the nut approximately 
seven flats (420 degrees). 

Replacing a Connection  

When reattaching tubing that already has a nut connected: 

1. Inspect ferrules. If you see any damage, replace the ferrules and 
follow the directions above for making a new connection. 

2. If there is no damage, hand tighten the connector to the analyzer’s 
INLET. 

3. Using a 5/8" wrench (not included), tighten the nut approximately 
one flat (60 degrees).  

7.4 Water Removal from the Gas Stream 

The G5131-i analyzer requires water removal from the gas stream prior to 

its admission to the analyzer. In order to achieve this purpose, Picarro has 

embedded a Nafion® dryer tube inline of the analyzer inlet stream. The 

dryer uses part of the pump exhaust as a counter-current gas in order to 

drive off the water from outer walls of the Nafion® dryer in order to 

regenerate its drying capacity. 



 

G5131-i User Manual P/N 40-0008 Rev. D 29 

Figure 12: 
Dryer Tube 

 

 

Nafion ® 

Dryer Tube 
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8. ANALYZER BASIC OPERATION 

8.1 Startup Procedure  

This section describes the steps to power on the system. These steps are 

sufficient for operating the instrument. 

1. Switch on the main power to the analyzer at the rear panel.  

Figure 13: 
Main Power 

Switch 

 

2. Press the soft power button located on the front panel. The software 
will start automatically, and the analyzer will display the CRDS Data 
Viewer window. Data Viewer features are detailed in Section 9.  

3. Wait approximately 45 minutes for the system to power, initialize, 
and stabilize. 

4. Once the cavity pressure and operating temperature are at their 
proper setpoints and stable, the analyzer will start measuring. 

 
NOTE 

As the instrument is starting up, it is normal for there to be a delay in 

reporting data. This can take several minutes depending on how long it 

takes for the internal temperature and pressure to reach their operating 

points, and it is normal during this time for some concentration readings to 

be negative or constant.  

The data selection pull-down menus will not be populated with the 

appropriate items until actual data is being reported in the graph. This is 

typically less than 30 minutes, but depending on ambient temperature, the 

analyzer can take up to 1 hour to stabilize. 

5. Select N2O from the Data Key dropdown menu in the CRDS Data 
Viewer screen. Figure 14. 

6. Restart the analyzer: double-click the Picarro Mode Switcher icon 
on the desktop and select Isotopic N2O. 

If you get logged off of Windows at some point, the username you 
log into is Picarro and Password: Extreme_Science! 
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Figure 14: 
Picarro 

Analyzer GUI 

 

8.2 Desktop Icons and Folders 

On the Windows™ desktop, there will be the following icons and folders: 

1. Start Instrument: When clicked, the analyzer will start measuring in 
the configuration that it was in when the software/analyzer was shut 
down. 

2. Coordinator Launcher: Depending on the system’s configuration, 
the coordinator program may not be included. Clicking on this icon 
will lead you to a window that will allow you to choose the proper 
coordinator to operate the peripheral module that came with your 
analyzer.   

3. Picarro Mode Switcher: When clicked, you will be led to a window 
that will allow you to switch between various measurement modes. 
Most analyzer models are configured for one mode and may not 
include the Mode Switcher. If the analyzer has multiple modes, this 
allows the user to switch between them easily. 

Data Key 

Dropdown Menu 

(Select N2O) 
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Figure 15: 
Picarro Mode 

Switcher 

 

4. Picarro Controller: When clicked, you will be led to a useful 
diagnostic panel allowing the user to see the analyzer’s internal 
temperatures, pressure, and spectroscopy in real time. This 
program has user-accessible functions, but it cannot change 
anything related to analyzer functionality. It is intended for diagnostic 
purposes only. 

5. Picarro Utilities Folders:  

a) Data file Viewer: When clicked, you will be led to a window 
that will allow you to convert between *.dat and H5 data files 
and to make various graphical representations of the data. 
The instructions on using the Data File Viewer software are 
described in the Appendix B  

b) Data Recal: When clicked, you will be led to a window that 
will allow you to recalibrate the data based on known, 
certified data. 

c) Setup Tools: When clicked, you will be led to a window that 
will allow you to edit various settings for the analyzer (See the 
Setup Tool section of this manual for information about these 
settings). 

6. Diagnostic Folder 

a) Stop Instrument: When clicked, you will be led to a window 
that will allow you to turn off the analyzer in an emergency 
event. Upon clicking on this icon, the following window will 
pop up. Please see Shutdown Procedure on page 33 of this 
manual to shut down the analyzer in normal circumstances. 
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Figure 16: 
Stop CRDS 

Software  

 

 

 
CAUTION 

EXCEEDING GAS INLET PRESSURE OR TEMPERATURE 

SPECIFICATIONS COULD RESULT IN DAMAGE TO THE 

INSTRUMENT. In the case of higher input pressure or flow, 

configuring a sampling bypass manifold system is recommended. 

Use a ‘tee’ at the gas inlet and either return the remainder to the 

main gas stream or exhaust appropriately. 

 

 
CAUTION 

Do not disconnect the AC power to the analyzer, vacuum line or the 

AC power to the External Vacuum Pump while analyzer is 

operating. Damage may be caused by current surges if power is 

applied while attaching or removing cables. 

 

 
CAUTION 

Analyzers which include the external valve control option are 

provided with a cable consisting of five electrical connections 

intended for controlling solenoid valves (typically 12VDC <1A max). 

 It is important to electrically isolate the solenoid valves from the 

analyzer’s ground to avoid electrical interference which could 

compromise the analyzer’s accuracy. 
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8.3 Shutdown Procedure 

 
CAUTION 

A flow of clean, relatively dry gas should always be directed to the 

instrument for several minutes prior to shutting down. Trapping a 

high-moisture content gas sample in the cavity can cause 

condensation damage to the mirrors as the instrument cools from 

its operating temperature. 

To shut down the analyzer using the GUI:  

1. Click on the “Shutdown” button located on the left side of the Data 
Viewer window.  

2. A window (will pop-up prompting the user to confirm the shutdown. 
Once confirmed, the analyzer software and hardware will turn off.  

The analyzer shuts down: 

3. Cavity fills with gas from the inlet until it reaches near atmospheric 
pressure. 

4. Status log shows the pressure as the cavity is filled. 

5. Proportional valves close. 

6. Software shuts down. 

7. Analyzer powers off. 

8. When the soft shutdown is completed, shut off the main power using 
the power switch on the back panel. 

 
CAUTION 

Do not turn off the pump or disconnect the vacuum line while the 

instrument is operating. 

 

 
CAUTION 

FOR G2xxxx ANALYZERS: If you have trouble turning off the 

analyzer software, do not kill the process(es) in the task manager; 

rather, double-click on the "Stop Instrument" icon in the 

Diagnostics folder on the desktop. 
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Figure 17: 
Shutdown 

Window 

 

8.4 Recovery from Electrical Power Outage 

When the power returns after an unplanned outage, the analyzer restarts 

automatically. The Picarro software: 

• Closes files that were interrupted by the power outage. 

• Opens new files for data collection. 

• Data, analyzer diagnostics and other parameters recorded up to the 

time of power outage are retained. 

If short power outages will be a routine operating environment, Picarro 

recommends using power conditioning or an uninterrupted power supply to 

help prevent damaging operating system and software corruption problems 

that can occur with repeated crashes. 
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9. LIST OF GUI FUNCTIONS 

9.1 GUI Overview 

The features of the Picarro analyzer GUI are identified in Figure 18 and 

described in the following sections.  

 
NOTE 

Note that the types of data shown in the following illustrations may differ 

from this model. This section generally shows the available features 

common to most models. 

 

Figure 18: 

G5131-I GUI 
Data Viewer 

 

9.2 Settings, Tools, and Help Menus 

Settings Menu  

Left clicking on the Settings menu pulls down a menu that has one entry 

‘Change GUI Mode from Standard to Service.’ This is the access point to a 

password protected service mode where additional operational and 

measurement parameters are displayed. Selecting and clicking on this 

entry opens the Cavity Ring-Down Spectrometer Controller. This is 

reserved for Picarro service operators only. 
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Figure 19: 
Settings Menu 

 

View Menu 

This menu item has three entries: 

Figure 20: 
View Menu 

 

1. Lock/Unlock time axis when zoomed: When locked, forces the two 
graphs to display the same time scale during zoom. 

2. Show/hide statistics: Toggles the measurement statistics display, 
see Digital Readouts section on page 42 below. 

3. Show/hide instrument status: Toggles the status of the instrument 
display.  

Tools Menu 

This menu item has two entries: 

Figure 21: 
Tools Menu 

 

1. User Calibration: Opens the user calibration window (default 
password is “picarro”). The password can be reset in the 
QuickGui.ini file in the instrument directory: 
“C:\Picarro\G2000\AppConfig \Config\QuickGUI\” under the section: 
[Authorization] UserCalPassword = Picarro Show/Hide Valve 

2. Show/Hide Sequencer GUI: Toggles the display of the external 
valve sequencer window. 

The calibration slope and intercept can be entered, and their effects 
immediately were seen in the data. Please refer to the Calibration 
Section on page 64. 
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Help Menu 

About: Displays the version number of the instrument. 

9.3 Alarms Panel 

Figure 22: 
Alarms Panel 

 

This panel is used to monitor the status of the internal instrument alarms. 

These indicators are gas concentration alarms, such as “N2O Too 

High/Low” depending on instrument configuration. The gas concentration 

alarm LEDs are off (grayed) when the respective concentrations are below 

a certain value, and they are illuminated when the respective 

concentrations are above/below a certain value. 

To view the alarm set point, click on the LED and a dialog box will appear 

indicating the alarm setting and allow the user to enable it or change the 

setpoint: 

Figure 23: 
Alarm Setting 

Window  

 

Type the value you wish to set the alarm to and press the “OK” button, or 

press “Cancel” if you do not wish to change the alarm value. If you do 

nothing, the dialog box will disappear, and the alarm value will remain 

unchanged. 
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9.4 Instrument status 

If these parameters are enabled through the ‘Show Instrument Status’ 

entry in the ‘View’ Menu on the main toolbar digital readouts for Warm Box 

temperature, Cavity Temperature and Cavity Pressure are displayed to the 

left of the main trend graphs. 

Figure 24: 
Instrument 

Status  

 

9.5 Data Log Filename and Path 

The filename and path of the active data log are displayed in this pan. The 

indicator is grayed-out if there is no active data log (i.e., if a new data log 

has not been started using the Start /Stop New Data Log Button). A new 

file will be generated at midnight, which will be saved to the same location 

as the original log file. 

Figure 25: 
Data Log 
Filename  

 

9.6 Data Window 

The data window displays a graph of any stream of data vs. system time, 

with a format of hh: mm: ss. The user can select which data stream is 

displayed using combinations from the Data Source and Data Key pull-

down menus. The precision displayed can be adjusted using the 

“Precision” menu and Auto-scaling of the ‘Y’ axis is also available. 
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Figure 26: 
Data  

Window 

 

Data Source and Data Key Pull Down Menus 

These two menus enable selection of the data stream that is viewed in the 

data window. Data streams available on the GUI are gas concentrations, if 

‘instrument Analysis’ (where instrument represents the system installed) is 

selected, or if “sensors” is selected, the analyzer’s optical cavity pressure 

or temperature can be viewed as well as the nominal ambient temperature 

of the analyzer (“DAS temp”) and the temperature of the analyzer’s 

electronics chamber, indicated as “warm chamber temp.” 

Figure 27: 
Source and Data 

Key Pull-Down 
Menus 

 

 

Precision Pulldown Menu 

Click on this icon to select the precision displayed on the y-axis, between 0 

and 4 digits of precision or “auto.” The currently selected precision is 

displayed during operation. This does not affect the precision of the saved 

data in the data log files or results files. 

Figure 28: 
Precision 
Pulldown  
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Data Buffer Level Meter 

The meter to the right of the Data Window indicates how much of the 

internal memory of the GUI is used to retain historical data collected with 

the instrument. There is an internal limit of a finite number of points. Once 

that number of data points is collected, the buffer is full, and old data is 

removed from the buffer as new data is collected. This buffer affects only 

the data displayed in the data window, not the data stored in any files. This 

buffer is empty upon instrument startup and can also be emptied by 

pressing the reset data buffer button in the lower-right-hand corner of the 

GUI. 

Figure 29: 
Data Buffer and 

Reset Buffer  

 

Reset Data Buffer Button 

Press this button to clear the internal data buffer of the GUI (this clears the 

current data traces from the graphs). This has the effect of clearing all data 

in the data window. Pressing this button has no effect on any of the data 

log files stored by the instrument. 

Graph Zooming 

To zoom the graph, simply drag the magnifying glass over the section to be 

zoomed and click and hold the left mouse button. While holding down the 

left button, move the mouse to create a box that covers the region of 

interest. When the box is properly drawn, release the left button and boxed 

area will automatically scale to fill the data window. To zoom back out, 

double-click on the left button. To auto scale, the y-axis of either graph, use 

the auto-scale buttons below the graph. To lock or unlock the time axis of 

each graph during zooming, select that menu item in the ‘View’ menu. 
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Figure 30: 
Graph  

Zooming  

 

Digital Readouts 

Displays the latest value recorded for the selected Data Key for each Data 

Window. Changing the Data Key modifies the Digital Readout as well as 

the Data Window view. If the ‘Show Statistics’ entry is enabled in the ‘View’ 

menu, the mean, standard deviation and slope of the data in the graph are 

dynamically calculated and indicated below the digital concentration 

readout. These numbers change to reflect statistics of whatever data is in 

the data window. 

Figure 31: 
Digital  

Readout 

 

Start / Stop Data Log Button 

The Analyzer automatically records all data collected on the instrument and 

saves it for later analysis. These files are called Data.dat files, which are 

described below in the section called File Management. In addition, the 

user can record a separate data log file. Press this button if you would like 

the instrument to start recording a separate data file. A dialog box will 

appear prompting you for a filename and location. Press this button again 

to stop recording the data file. 
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9.8 Status Log Window 

This window displays instrument status messages, in the following form: 

“MM/DD/YYYY hh: mm: ss generic message text.” These messages 

include all messages sent to the DAS front panel display. The common 

status log messages are: 

3. Temperature Locked: WB (HB) 

The system waits for the warm box (“WB” – the temperature-
controlled electronics and wavelength monitor chamber) to reach 
operating temperature. Similarly, the temperature of the hot box 
(“HB” – the temperature-controlled chamber containing the 
analyzer’s optical cavity and gas handling system) is stabilized. This 
is typically the longest step in the startup sequence. The duration of 
this step can range from 5 to 60 minutes, depending on the ambient 
temperature and how much time has elapsed since the last startup. 

4. Entering Measurement  

Spectral scanning has started. Concentration measurements will be 
available in approximately 30 seconds. The instrument will continue 
to scan and report concentration measurements until the instrument 
is shut down using the procedure below. 

5. Pressure Stabilizing/Locked 

The valve control system begins to allow flow through the analyzer 
and stabilizes the pressure inside the cavity. 

6. Measuring  

This is the normal mode of operation after startup has completed. 

Figure 32: 
Status Log 

Window 
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10. MAINTENANCE 
Picarro analyzers require minimal service or maintenance. With the exception of 

the particulate filter, and refilling the chiller, and replacing fuses, the analyzer is not 

user serviceable. 

Before performing any maintenance shut down the analyzer. 

10.1 Cleaning 

Clean the outside of the analyzer with a clean dry cloth. Users should 

never access or clean the inside of a Picarro analyzer. 

10.2 Fuse Replacement Procedure 

Fuse replacement can be performed by users. The analyzer uses a 1.5A at 

250 VAC, 5mm x 20mm, slow blow fuse. Follow this procedure to replace a 

fuse. Figure 33 shows the fused power connector on the lower right corner 

of the PPU rear panel (Figure 33). 

Figure 33: 
Analyzer Fuse 

Location 

 

 

 
WARNING 

Before replacing a fuse, make sure that the analyzer power is off 

and that the power cord is disconnected. 

1. Insert a screw driver flat head under the tab on the fuse housing. 

2. Carefully push the screw driver handle away from you to lever the 
fuse housing out of the analyzer back panel. 

3. Remove the fuse from the fuse housing as shown in Figure 34. 



 

G5131-i User Manual P/N 40-0008 Rev. D 45 

Figure 34: 
Fuse 

Replacement 

 

4. Put a new fuse in the fuse holder. 

5. Push the fuse holder into the rear panel. You will hear a click when it 
is fully inserted. 

10.3 Particulate Filter Replacement 

Gasses are filtered by two in-line, sub-micron particulate filters before the 

reaching the measurement cavity. The outer filter is user-replaceable. 

Replacement filters can be purchased from Picarro and installed by users. 

This section describes outer filter replacement. 

 
WARNING 

The inner filter is NOT user replaceable. Do NOT open the hot box. 

Inner filters must be replaced by a Picarro certified technician. 

USER REPLACEMENT OF THE INNER FILTER OR BREAKING THE 

ANTI-TAMPER TAPE ON THE INNER FILTER VOIDS THE 

WARRANTY. 

Symptoms of a Clogged Filter 

Filters can become clogged with continual use. 

If liquid water is sucked into the inlet line, it may clog the filter and impede 

the flow (usually for a few days) until it evaporates. 

Some symptoms of a clogged filer are: 

• The analyzer pressure is low. 

• Low flow into the analyzer, causing unusual measurements. 

• Response time is slower than usual. 
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Solutions 

Do NOT turn off the analyzer when a filter is wet or replace a wet filter. 

Liquid water in the filter can cause condensation on the optics if the 

analyzer is allowed to cool when the filter is wet. 

• Dry the filter by running Clean Dry Air (CDA) through the analyzer. If the 

analyzer functions normally after drying, a filter replacement is not 

necessary. 

• If drying the filter does not fix the problem, replace the filter. 

Tools Required 

Make sure you have these tools before starting the filter replacement: 

• 9/32 nut driver 

• 7/8” open-end wrench 

• 9/16” open-end wrench 

• Needle-nosed pliers 

• 1.5 mm hex wrench 

Figure 35: 
Tools Required 

 

Particulate Filter Removal 

1. Move the analyzer to a clean environment. 

2. Using the 2mm hex driver, remove analyzer top lid by removing six 
(3 per side) M3 x 6mm socket flathead screws. 

3. Lift the top cover off of the analyzer. 
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Figure 36: 
Foam Removal 

 

4. Remove the foam sheet from the top of the analzyer. 

Figure 37: 
Filter Exposed 

 

5. Loosen the filter output nut. (Fig 37) 

Figure 38: 
Filter Outlet 

Nut 

 

  

Remove 

nut 

Filter 

Location 

Filter 

Location 

Remove 

Foam 
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7. Remove the two screws that secure the inlet bulkhead (Fig 39). 

8. Pull out the Inlet bulkhead with filter still attached.  

Figure 39: 
Remove 

Bulkhead 
Screws 

 

9. Remove the filter from the inlet bulkhead by loosening the attaching 
nut. 

10. Attach new filter in the correct orientation (observe flow arrow 
direction). Installation is the reverse of removal. 

10.4 Laser Chiller Service 

The analyzer is equipped with a chiller (40ml water buffer tank) for laser 

cooling. Figure 40 shows the buffer tank. 

• The recommended coolant is from Koolance, PN # LIQ-702. It is a 

solution of distilled water and propylene glycol. 

• The buffer tank is filled with coolant when shipped. Refill or add for 

cases when empty or at a low-level. 

• Make sure there aren’t any kinks / twists in the exposed coolant tubes, 

especially during an analyzer’s installation or after a relocation. 

• Instrument must be powered off before connecting coolant tubes and 

the initial fill or drain of buffer tank.  One may leave the analyzer on 

when refilling a tank with low coolant using the two ports on top of the 

tank’s lid. 

• Picarro recommends inspecting the coolant level in the buffer tank and 

adding or refreshing in case of coolant loss or contamination. 

• Coolant consumption is dependent on many factors. Recording the 

frequency for coolant maintenance can be helpful. 

Remove Remove 
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Buffer Tank Initial Coolant Fill 

Following is a procedure for the initial fill of the buffer tank: 

1. Seat the analyzer’s main box and PPU on a table. 

2. Inspect buffer tank for possible crack and/or external tube breakage. 
Repair before filling.  

Figure 40: 
Chiller Buffer 

Tank 

          

3. The black top lid of the buffer tank should sit slightly higher than the 
top of main box. Adjust tank level, if necessary. 

4. Remove the black top lid by turning counter-clockwise. Fill the buffer 
tank with coolant until full; secure top lid to seal the tank. On top of 
the lid, are two ports, which can also be used to fill and refill tank. 

Figure 41: 
Filling the 

Buffer Tank 

 

5. Disconnect the quick connectors from each other, as they are 
shipped plugged into each other. Then plug them into the two quick 
adaptors at the bottom of the buffer tank, as shown in Figure 42. 
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Figure 42: 
Buffer Tank 

Connections 

 

6. Power on the analyzer to check the coolant flow. In a normal 
operating condition, coolant will be visible inside the tank. If 
necessary, add more coolant to buffer tank. 

Refilling the Chiller  

In the event coolant level is below the minimum level marker on the tank, a 

refill is necessary. 

1. Analyzer can be ON or OFF for this operation. 

2. Perform Step 4 of initial coolant fill.   

3. Turn on analyzer to circulate coolant in tank for 5-10 minutes. 

4.  Check level and flow. Add more coolant if necessary. 

5. If coolant is contaminated, turn off analyzer, drain buffer tank, and 
reconnect the tubes, before performing Steps 2 - 4. 
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11. TROUBLESHOOTING 
This section lists problems that may occur during installation and operation of the 

analyzer, and step-by-step procedures that will provide resolution in most cases. If 

these instructions do not solve the problem, contact Picarro Technical Support. 

11.1 Power LED on Analyzer Does Not Illuminate 

Pressing the front panel ON button does not start the analyzer. The green 

power LED is normally illuminated when the analyzer is on. 

1. Check that the AC power cord is attached and plugged into a 
working outlet. 

2. Check that the rear ON-OFF switch near the AC power cord is in the 
ON position. 

3. Press and hold the front panel power switch for at least 5 seconds 
as the analyzer may take several seconds to respond. 

11.2 GUI Does Not Display at Start-Up 

The computer may be configured to either: 

• Automatically start the analyzer and GUI after it completes its boot-up 

sequence 

• Launch the GUI using the Start Analyzer icon on the desktop 

To configure the computer: 

1. Shut down the analyzer by shutting down Windows on the on-board 
computer. 

2. Wait for the shutdown to complete normally and for the computer 
and analyzer to turn off completely. 

3. After a few seconds, restart the computer by momentarily pressing 
the power button on the front panel. See Figure 6 for the location of 
the front panel power button. 

 
CAUTION 

 
Do not restart windows without cycling the power to the 
analyzer. Restarting windows will not fix this problem. 
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11.3 Cavity Pressure Cannot be Adjusted for Concentration 
Measurements 

The cavity pressure is automatically locked to the correct value during 

normal operation. 

The Pressure Locked message on the on the lower left corner of the GUI 

indicates that the cavity pressure is within operating parameters. See 

Figure 43. 

Figure 43: 
Status Log 

for New Filter 

 

If the cavity pressure is out of operating specification the GUI displays a 

Pressure high or Pressure Low message. 

1. The Pressure Low message on the GUI indicates that there is 
insufficient gas available at the analyzer gas inlet.  

a. Check the inlet plumbing to the analyzer. 

b. Ensure that the pressure at the inlet is within specifications. 

2. The Pressure High message on the GUI indicates that gas cannot 
exhaust from the analyzer at a sufficient rate.  

a. Check the vacuum line between the analyzer and the power 
vacuum unit for leaks. 

b. Check the vacuum pump. Make sure it is functioning 
correctly. 

c. Check the gas pressure inlet for excessive pressure. 
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11.4 User Interface Program Does Not Update Graphs as 
Data is Collected 

The computer may become unresponsive causing the programs that 

control the analyzer to stop functioning. If this happens: 

Shut Down the Computer 

If the computer responds to the mouse, do a normal Windows shutdown 

from the Windows start menu: 

1. Wait until the computer is completely shut down. 

2. After a few seconds, start the computer using the power button. 

If the computer does not respond to the mouse: 

1. Hold down the power switch on the front panel for a few seconds 
until the computer and the analyzer turn off.  

2. After another few seconds, restart the analyzer using the power 
button. 
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12. FILE MANAGEMENT 
The analyzer generates ASCII-format text output files. Data files are created every 

15 minutes by default.  

The file name is generated from the analyzer serial number, the date, and the time 

when the analyzer was started. For example: 

 

JKADS2001-20160127-1029-DataLog_User_Raw.dat 

JKADS2001 is the analyzer serial number 

20160127 is the date, 1/27/2016, in format yyyymmdd (to allow chronological 

sorting of data files). 

1029 is the time the file was started in GMT, 10:29 am, formatted as hhmm using a 

24 hour clock. 

The raw user data is contained in folders in the directory:  

• C:\UserData \DataLog_User\year\month\day\hour. (for data that has 

been sampled at the analyzers native sampling rate). 

• C:\UserData\DataLog_Sync\ month\day\hour (for data that has been 

sampled at a constant rate. 

Data files are created every 60 minutes and stored for 90 days (default for SADs 

analyzers) before they are automatically deleted. File deletion frequency and 

details can be modified in the file: 

C:\Picarro\SI2000\AppConfig\Config\Archiver\Archiver.ini. See File Archival and 

Automatic Deletion of Old Files. 

During data acquisition, the analyzer creates directories to store the data, filed by 

the date the data were acquired. 

The figure below shows a partial example of a data file. 
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Datafiles are closed every 15 minutes and moved to an archive directory and a 

new datafile is started. 

The archive directory is C:\Picarro\ G5000\Log\Archive\ and has subdirectories 

DataLog_Mailbox, DataLog_Private and DataLog_EventLogs with files arranged 

by year\month\day\hour. 

There are more complete data files which include additional information beyond 

the concentration data including parameters such as analyzer temperatures and 

pressure, setpoints and spectroscopic information. This information is generally not 

useful to the user, but can be useful for diagnostic purposes and is store in the 

directory C:\Picarro\ G5000\Log\Archive\DataLog_Private \year\month\day\hour. 

For more information about how to include various columns of data from the 

DataLog_Private in the C:\UserData DataLog files, contact Picarro. 

The currently active data file can be found in C:\Picarro\ G5000\Log\DataLogger\. 

Archive directory contain subdirectories arranged by file type and internally 

organized by \year\month\day\hour.  

To keep the data files easy to manage and to limit the size of individual files and 

directories, new files are automatically generated whenever the analyzer is 

operating. 

The software automatically generates new files each time the analyzer is powered 

up and also at midnight (GMT) each night. When new files are created at midnight, 

their file name will contain the new date and a time of 00:00. 

For example, if the system was started at 10:29 am on 2/5/2016 it would create a 

file named 20160205\S 

JKADS5310-20160205-1029-UserLog.dat. Then at midnight a new file will be 

created -20160206-0000-UserLog.dat. 

12.1 File Archival and Automatic Deletion of Old Files 

The analyzer can automatically compress (zip) and archive old files as 

mentioned above. This operation is controlled by the ini file: 

C:\Picarro\G5131-I\AppConfig\Config\Archiver\Archiver.ini.  

For each file type, there are various items along with some recommended 

default settings which may vary by file type: 

Directory = C:/UserData/DataLog_Sync 

Optionally specifies which directory to find files to archive. 
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MaxCount = -1 

Specifies how many files to keep. A setting of -1 indicates that there is no 

maximum number of files. Generally, -1 is used in conjunction with a 

maximum size limit, below. 

MaxSize_MB = 1500 

Specifies that a maximum of 1.5 GB of data is to be kept before the system 

begins to delete old data. 

Compress = True/False 

Specifies if archived files are to be zipped – recommended setting is true to 

save hard drive space. True means files are zipped, false means files are 

not zipped. 

AggregationCount = 0 

If compression is set to TRUE, specifies how many files to be included in 

each zip archive. 

StorageMode = FIFO 

First in first out. Specifies that old data is deleted first. 

Quantum = 4 

Generally, should not be changed. Specifies the files be sorted by 

year\month\day\hour in the archived directory structure. 

In addition to the automatic file and directory management described 

above, the analyzer also automatically deletes various files specified in 

C:\Picarro\ SI2000\AppConfig\Config\FileEraser\FileEraser.ini. There are 

various settings, as described below: 

runtime_interval_hrs = 0.5 

Specifies how often (in hours) to run the file eraser. 

path = ../../../Log/Archive/DataLog_Private 

Specifies which directory to look in for files to delete. 

extension = dat 

Specifies which files having what extension are to be deleted. If empty, it 

deletes all files. 

delete_time_hrs = 48 

Specifies how long to keep files prior to deletion. 
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12.2 Setup Tool 

In the desktop folder called Picarro Utilities, the Setup Tool can be 

launched by double clicking on its icon. The tool allows the user to 

configure data file saving details, including which data elements are written 

to data files, digital data output (via serial port or TCP/IP), remote data 

delivery (via email), and general GUI properties.  

Data Logger 

The Data Logger tab allows the user to configure various data file saving 

details, including which data elements are written to data files.   

• Data Columns: Controls which data elements are written to data files.  

• Hours of Each Log File: Controls the size of each data document.  

• Enable Mailbox Archiving: Enables archiving of data in the mailbox 
folder: C:\Picarro\G2000\Log\Archive\DataLog_Mailbox 

• Archived Directory Structure: Specifies part of naming convention for 
data documents.  

• Total User Log Storage Size (GB): Specifies the size of storage 
allowed for User Data (Recent Data).  

After making the appropriate edits, click “Apply” to put changes into effect 

and then “Exit” to close the window. 

Figure 44: 
Data Logger 

Setup Window 
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Serial/Socket Port Manager 

The Port Manager tab allows you to control digital data output/Input via 

serial port or TCP/IP. 

• Data Streaming: specify the port for data streaming 
(COM1/COM2/Off) 

• Valve Sequencer MPV: specify the port for connecting to Valve 
Sequencer (COM1/COM2/Off) 

• Command Interface: specify the port for Command Interface 
(COM1/COM2/ TCP/Off).  

Make sure there are no COM port conflicts before clicking “Apply.” After 

making the appropriate edits, click “Apply” to put changes into effect and 

then “Exit” to close the window. 

Figure 45: 
Serial/Socket 

Port Setup 
Window 
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Data Delivery Setup 

The Data Delivery tab allows the user to schedule remote data delivery via 

email. 

• Delivery Start Time: Time of the day when data will be sent.   

• SSL: Depending on the sender’s email server, the sender can 
activate the Secure Sockets Layer (SSL).  

• Use Authentication: Turning this on will require the receiver to 
provide a password and a username to access data. Set up the 
password and Username from this window. 

• From: Sender’s email 

• To: Receiver’s email.   

• Subject: subject line of the email.  

• Data Directory: Location of the data you want email.   

After making the appropriate edits, click “Apply” to put changes into effect 

and then “Exit” to close the window. 

Figure 46: 
Data Delivery 

Setup Window 
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Editing Main GUI Properties 

The GUI Properties tab allows you to set the number of line graphs visible 

on the main GUI.   

In this tab, you can enable control of a connected Valve Sequencer from 

the main GUI: 

3. Click on “Settings” of the “Setup Tool” window, and then “Switch to 
Service” mode.  

4. Choose “Yes” next to “Enable Control Valve Sequencer” drop down 
menu on the “GUI Properties” tab.  

5. Click “Apply” to put changes into effect and then “Exit” to close the 
window. 

You should now be able to access the “Show/Hide Valve Sequencer GUI” 

menu from the main GUI under “Tools” 

Figure 47: 
GUI Properties 

Window 
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Specifying Digital Data Output for Command Interface 

The Command Interface tab allows you to specify the data elements that 

are sent via COM port/TCP (specified in the Port Manager tab). Two types 

of data can be specified here: Datalog_User and DataLog_User_Sync.  

After making the appropriate edits, click “Apply” to put changes into effect 

and then “Exit” to close the window. 

Figure 48: 
Command 

Interface 
Window 
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Specifying Digital Data Output for Data Streaming 

The Data Streaming tab allows you to specify the data elements that you 

want to send via COM port (specified in the Port Manager tab). Two types 

of data can be specified here: Datalog_User and DataLog_User_Sync.  

Data Streaming outputs data continuously, whereas the Command 

Interface needs commands to prompt data output. 

After making the appropriate edits, click “Apply” to put changes into effect 

and then “Exit” to close the window. 

Figure 49: 
Data  

Streaming 
Window 
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Customizing Analog Output Channels 

The Picarro analyzer may be optionally configured with an Electrical 

Interface Card (EIC) that provides up to 8 analog signals available to the 

user for monitoring various measurements results and analyzer 

parameters. 

Electrical Interface 

The Electrical Interface tab allows you to customize each analog output 

channel. This tab will be disabled if the analyzer was not configured to 

work with an analog peripheral. 

After making the appropriate edits, click “Apply” to put changes into effect 

and then “Exit” to close the window. 

Figure 50: 
Electrical 
Interface 
Window 
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13. CALIBRATION 
The two primary analytical measurements of the instrument are the concentration 

of 12CH4 and 13C-CH4. Periodic recalibration with standards of known 

concentration maintains the accuracy of these quantities. Using the Data Recal 

Software Utility (See instructions in Section 13.3: Calibration Software Utility Tools) 

enables the calibration constants to be tracked over time, thus enabling the user to 

follow system performance. 

13.1 Slope and Offset 

Every Picarro analyzer ships with a default user calibration value of 1 for 

slope and 0 for offset. While new user calibrations will likely result in 

changes to both, we recommend that only offset changes are applied 

during more frequent calibrations. 

If a new slope calibration is to be applied, the user must be mindful of their 

experimental uncertainty. For example, a change in the slope calibration 

from 1 to 0.95 may not represent a change in the system’s linearity but 

may simply reflect the experimental uncertainty. If during the slope 

calibration, a new value of 0.9 or 0.85 is suggested by the Data Recal tool, 

please repeat the measurements of the standards. In most cases, such 

large changes in slope are a result of uncertainty and do not indicate a bad 

nonlinearity of the analyzer. If the analyzer continues to suggest a large 

change in slope, please consults with Picarro Support before applying a 

new calibration. 

 
NOTE 

If you are uncertain about the state of the current slope and offset 

values, they can be reset back to their user default values of 1 and 

0, respectively. In the Picarro GUI, navigate to “Tools -> User 

Calibration -> (password: picarro) ->” Then change the slope and 

offset values of the parameter of interest to 1 and 0, respectively. 

13.2 Calibration Methodology 

To perform a calibration or verification of calibration, the user simply 

introduces the calibration standard into the analyzer for a period long 

enough for the analyzer to yield a stable measurement of that sample. 
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Calibration Setup 

This section describes the connections from the analyzer to the gas tank. 

• The pressure regulator at the outlet of the gas tank protects the 
analyzer from over-pressurizing. The pressure should be set to 
about 1 - 3 psi. 

• The toggle valve allows rapid shutoff of the gas delivery. 

• Tubing is connected to the male quick-disconnect connector 
provided with the analyzer. 

• The male connector is inserted into the inlet port of the analyzer. 

To replace the gas tank:  

6. Turn off the main valve on the gas tank. 

7. Disconnect the pressure regulator assembly from the tank. 

8. Connect the pressure regulator assembly to the next gas tank. 

Measurement Time for Each Standard 

The measurement period for a calibration standard is dependent upon the 

recorded precision of the standard gas and performance characteristics of 

the analyzer, using the Allan standard deviation plot.   

Measuring Multiple Gas Standards 

When measuring multiple gas standards, the order of the gas standard is 

not important. However, make sure that you measure the gas standard 

slightly longer than the time you determined in the previous section 

because the usable/effective data set will be trimmed down. 

Calibration Data Processing 

1. Process the calibration results from the .dat file (see File 
Management on page 54) and calculate the average recorded value 
for each standard. 

2. Plot these values versus the certified values from the gas supplier 
and determine the linear relationship between the known calibration 
values and the analyzer’s reported values. A linear best-fit equation 
can be calculated from the data. 
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.  
NOTE 

It is important to plot the analyzer’s reported concentration on the 

horizontal axis and the gas standards’ stated concentrations on the 

vertical axis. 

The slope and intercept of the best-fit line through these points are the two 

values that are used to calibrate the analyzer. By determining the linear 

relationship between the known calibration values and the analyzer’s 

reported concentration values in this way, a calibration offset (slope and 

intercept) can be calculated to add a correction term to the analyzer’s 

factory or previous calibration. 

Entering the Calibration Setting 

Changing the analyzer’s calibration is intended to be done infrequently. 

Instead of recalibrating frequently to increase the accuracy of the data, 

users often just verify the calibration by measuring three or more gas 

standards and use the same regression procedure described here to 

calculate an offset by which to correct their data offline. Using the following 

equation in the graph below, this calculation would be accomplished point-

by-point by calculating the corrected data “y” using the analyzer’s data “x” 

so that: 

Data corrected = 0.9866•Dataraw+5.268 

Figure 51: 
Linear 

Calibration 
Example 

 

Calibration values are input into the analyzer by selecting Tools > User 

Calibration, and then entering the slope and intercept for each species. 
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NOTE 

User Calibration is a password-protected form, and the default 

password is “picarro”. This password can be reset in the 

QuickGui.ini file as previously described.  

The calibration will take effect immediately after clicking OK. To return to 

the factory calibration, simply set the slope to 1 and the intercept to 0 for 

each species.   

13.3 Calibration Software Utility tools 

Data Recal  

The Data Recal software utility is designed to enable users to perform a 

routine concentrate calibration or calibration verification of Picarro’s gas 

concentration Analyzer via a user-friendly interface. 

Data Recal allows the input of ten calibration points. Some of these points 

can be used for recalibration, while the remaining points can be used as 

quality control calibrants. In an ideal situation, three concentration certified 

standards should be analyzed on the system to generate CRDS-reported 

values for concentration. The standards with isotopic values spanning and 

encompassing the intended sample analysis should then be used to build a 

standard calibration curve. Parameters of this curve will then be used to 

correct the instrument readings so that they match standard values. The 

other standards will be simultaneously used for quality control, to verify 

other recalibrated delta values against their certified delta values. 

Graphical User Interface (GUI) 

The Picarro Data Recalibration (“Data Recal”) software can be found in the 

“Picarro Utilities” folder on the desktop. The Data Recal software utility can 

be launched by double-clicking on the Data Recal Icon in the folder. Shown 

below is a screenshot of the window that will open. 



 

68 P/N 40-0008 Rev. D G5131-i User Manual 

Figure 52: 
Data Recal 

Software Utility 
GUI  

 

The Delta Recal Software Utility comprises three sections: 

1. A numerical input and selection section (shown below): 

Certified and CRDS reported values are entered in the white 
boxes. Standards that will be used for instrument recalibration are 
then selected by checking the corresponding box in the first column, 
labeled “Used for Recal.” 
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Figure 53: 
Recalibration 

section of Data 
Recal Software 

Utility GUI  

 

2. Calibration output section (shown below): 

In the “Calibration Options” drop-down menu, you can select either 
an “offset” or an “offset + slope.” Once the new calibration 
parameters are calculated, the Data GUI will display the new values 
under the “New Calibration” column. The parameters that appear 
here will depend on your initial selection. When the Offset + Slope 
option is selected, the program also calculates a goodness-of-fit 

correlation coefficient (R2). 

 

Figure 54: 
Calibration 

output section 
of Data Recal 

Software Utility 
GUI  

3. Action selection section (shown below): 

In this section, the user can click on the compute button to calculate 
the new calibration parameter(s). The compute button will be grayed 
out until values have been entered in the Certified and CRDS 
reported columns, and at least one pair of Certified and CRDS 
reported values selected for the calibration. Once these values are 
entered or selected, the “Compute” button will be active. Click 
“Compute” to calculate the new calibration parameters. These 
parameters will appear in the Calibration output section of the GUI, 
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and an asterisk “*” will be displayed at the end of the window title 
line, indicating the new change. 

 

Figure 55: 
Action selection 

section of the 
Data Recal 

Software Utility 
GUI 

 

Once the calibration parameters are calculated, you can elect to 

graphically display the calibration and quality control (QC) standards in a 

graph. To do this, click “Plot” in the upper left corner of the window, and 

select “Plot Linear Fitting” from the drop-down menu, as shown below. 

Figure 56: 
Delta 

Recalibration  

 

The plot that the utility will generate is shown below; this plot will display 

two graphs. The top graph presents measurements for the recalibrated 

standards (calibration and QC), as well as a line fit through those points. 

The bottom graph shows the residuals, which shows how far each 

measurement is from the best-fit line. 
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Figure 57: 
 Slope of Delta 

Recalibration 

 

If you decide to accept the new calibration values based on this plot, click 

on the “Apply New Cal” button. 

Figure 58: 
Apply new 

calibration slope 
and intercept   

Then you will be prompted to enter a Calibration Password. The default 

Calibration Password is PICARRO. 

Figure 59: 
User 

Authorization 
Dialog box  

 

Next, a “Recalibration Confirmation” pop-up window will appear, displaying 

the new offset and slope (when applicable) values. This window will prompt 
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you to confirm your choice to apply these values, to avoid any inadvertent 

mistakes. 

Figure 60: 
Calibration 

Confirmation 
Dialog box  

 

Please note that when you press the “Yes” button, the newly accepted 

calibration parameters will take effect immediately, without the need for the 

instrument main GUI to be restarted. 

Once you accept the new calibration parameters, the Data Recal Software 

Utility automatically gives you the option to save the new recalibration file. 

Saving these files enables you to track the instrument recalibration history. 

Saved files can be reloaded by clicking “File” in the upper left corner of the 

window and selecting “Load Recalibration File.” 

Figure 61: 
Delta 

Recalibration 
Load File   

Next, select the file that you want to load. 

Figure 62: 
File Browser 

Delta Recal File 
Option  

 

The recalibration file for this example will contain the following information: 
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Figure 63: 
Delta Recal  

Log File 

 

Row 
Number 

Certified 

Values 
Measured 

Values 
Recalibrated 

Values 

1 -35.6 -35.8 -35.20437 

2 8.6 7.6 7.64690 

3 37.5 38.4 38.05748 

4 cc 1.75599 0.55625 

5 nc 1.87678 
0.54922 

0.99949 

6 Option   Offset + Slope 

Rows 1 – 3: values from each standard selected for recalibration. The 

first column in these rows lists the certified values, the second column lists 

the measured values, and the third column lists the recalibrated values. 

The number of rows will depend on the number of standards selected to be 

used for recalibration. 

Row 4: Current Calibration (cc) Row: read from left to right, list the 

current offset and current slope value. 

Row 5: New Calibration (nc) Row: read from left to right, lists the new 

offset and new slope values. The third value in this row is the R2 value, 

which is only displayed if the calibration option is “offset + slope.” 

Row 6: Options Row: The last row displays the calibration option 

selected. If you choose to exit the Recal GUI before accepting the new 

recalibration values, you will be prompted to confirm your choice through a 

pop-up window. This window contains a warning that continuing to exit will 

cause the new calibration data to be lost. 

Figure 64: 
Recalibration 

Exit 
Confirmation  

 

When you are finished with the calibration, you can exit the Delta Recal 

software utility by clicking on the “Exit” button at the bottom part of the 

Recal GUI. 
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Figure 65: 
Calibration  
Exit Button  

 

 

 
NOTE 

The Recal GUI displays an error saying the new slope value is not 

acceptable when (1) at least two entries in the Certified or CRDS 

reported columns contain zero-value numbers, or (2) these entries 

are selected to be used for recalibration, or (3) the “offset + slope” 

calibration option is selected. This error occurs because the 

entered values will lead to an erroneous zero-slope value. 

 

Figure 66: 
Invalid New 
Slope Entry  
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14. STATUS LOG MESSAGES 

14.1 Normal Startup Messages 

Temperature Locked: WB 

The system waits for the warm box (WB – the temperature-controlled 

electronics and wavelength monitor chamber) to reach operating 

temperature.  

Temperature Locked: HB 

The system waits for the hot box (HB – the temperature-controlled 

chamber containing the analyzer’s optical cavity and gas handling system) 

is stabilized.  

This is typically the longest step in the startup sequence. The duration of 

this step can range from 5 to 60 minutes, depending on the ambient 

temperature and how much time has elapsed since the last startup. 

Preparing to Measure 

Spectral scanning has started. Concentration measurements will be 

available in approximately 30 seconds. The analyzer continues to scan and 

report concentration measurements until the analyzer is shutdown using 

the procedure below. 

Figure 67 shows an example of the status log messages for startup. 

Figure 67: 
Sample Status 
Log Messages 

for Startup 

 

Pressure Stabilizing/Locked 

The valve control system begins to allow flow through the analyzer and 

stabilizes the pressure inside the cavity. 

Measuring 

This is the normal mode of operation after startup has completed. 
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15. CONTROLLING EXTERNAL VALVES 
This section explains how to control external valves using the built-in External 

Valve Sequencer GUI.  

If you are using the optional Picarro 16 Port Distribution Manifold with the analyzer, 

see the 16 Port Distribution Manual User Guide for instructions on using the 

External Valve Sequencer GUI. 

15.1 Display the Show/Hide Valve Sequencer GUI 

1. Start the analyzer by double-clicking the Start Analyzer shortcut on 
the desktop. 

2. Wait for the analyzer to begin measuring. 

3. On the status bar menu of the analyzer Data Viewer screen, select 
Show/Hide Valve Sequencer GUI dropdown (Figure 68). 

The External Valve Sequencer GUI displays (Figure 69). 

Figure 68: 
Show/Hide 

Valve 
Sequencer GUI  

 

Figure 69: 
External 

Valve 
Sequencer 

GUI 
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15.2 The External Valve Sequencer Window 

This section describes the External Valve Sequencer window. 

15.3 File Menu 

Load a Valve Sequence File 

Click here to load saved files. Sequence Files are in: 

C:\Picarro\G2000\InstrConfig\ValveSequencer\Name of the Sequence File 

Save a Valve Sequence File 

Click Action/Save Valve Sequence File to save a valve sequence file. 

Figure 70: 
Valve 

Sequencer File 
Menu 

 

15.4 Action Menu 

See Figure 71 below. 

Start Sequencer 

Click here to start a sequence. 

Go to First Step 

Click here to run step one (automatically resets to 1 from whatever step is 

currently being sampled). 

Reset All Valves 

Click here to change current valve states to All off. 
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Hide Sequencer Interface 

This toggle shows or hides the Sequencer Interface window. To reveal the 

window click on the Show Sequencer Interface. 

Figure 71: 
Valve 

Sequencer 
Action 
Menu 

 

15.5 Current Status Fields 

The top row on the menu (Figure 69) gives the current status of the current 

step. 

Current Step # 

Gives the number of the current step as defined by the setup 

Remaining Time (min) 

Time remaining on the current step 

Current Valve State 

Check boxes indicate which valves are energized 

Current Valve Code 

Binary code representing which valves are energized 

Current Rot. Valve Code 

Used only with gas distribution manifold 

15.6 Step Definition Fields 

Use the step definition fields to define the test sequence. 

Step # 

Enter the step number. 
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Duration (min) 

Enter how long you want the step to last. 

Rot. Valve Code 

Used only with the gas distribution manifold 

15.7 Bottom Panel 

Use the bottom section of the window (Figure 69) to configure the sample. 

Total Steps 

Use this field to enter the total number of steps in the test. When the last 

step is finished, the sequencer loops back to the first step. 

Run Step # 

Shows the number of step currently running. If a different step is desired, 

enter that step number and click on Apply (Figure 43). 

Apply 

Click here to apply changes made using the External Valve Sequencer 

window. 

Run Next Step 

Forces the next step in the sequence. 

Start Date 

Use this field to enter the date to start the test. 

Start Time 

Use this field to enter the time to start the test. 

Schedule Sequence 

Click this button to have the sequence start automatically at the date and 

time specified in the Start Date and Start Time fields. 
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15.8 Set Up a Test Sequence Using the Valve Sequencer 
Window 

A variety of sequences can be created and saved External Valve 

Sequencer window. This section explains how to set up a test sequence 

using the External Valve Sequencer window. 

To set up a sampling sequence: 

1. On the Picarro analyzer GUI, go to: 

a. Tools 

b. Show/hide valve sequencer 

c. The External Valve Sequencer window displays. See Figure 
69. 

2. Use the Rot. Valve Code column to set the rotary selector valve 
position.  

3. Enter the number (1-16) that corresponds to the desired valve 
position. 

A value of 1 in the Rot Valve Code field corresponds to position 2 on 
the valve. Only one rotary position can be selected per step. 

4. Enter the Step duration in the Duration (min) field, where the 
duration of the step is in minutes. If duration values are set to less 
than 0.1 minutes they may not be carried out correctly. 

5. Save the valve sequence as: 

C:\Picarro\G2000\InstrConfig\ValveSequencer\Name of the 
Sequence File. 

15.9 Load and Run a Saved Sequence 

Load saved sequence files by clicking File/Load Valve Sequence. All the 

Sequence Files are in 

C:\Picarro\G2000\InstrConfig\ValveSequencer\Name of the Sequence File.  

1. Click Apply to run the sequence. 

2. To skip the next step click Run Next Step (even while in middle of 
running a step): 

3. Click on the Action scroll-down menu. 

4. Reset all Valves by changing all the Rot. Valve Code fields to Zero. 

5. Click on Go to the First Step (Whatever the step the user is at, step 
1 will be played). 
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6. Click on Start/Stop Sequencer (while the sequence is running, it 
will read Stop Sequencer). 

7. Click on Hide Sequencer Interface (which will hide the External 
Valve Sequencer window).  
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16. LIMITED WARRANTY 
Picarro, Inc. warrants its Products to be free from defects in material and 

workmanship and to perform in the manner and under the conditions specified in 

the Product specifications for twelve (12) months from shipment. 

This warranty is the only warranty made by Picarro with respect to its Products and 

no person is authorized to bind Picarro for any obligations or liabilities beyond this 

warranty in connection with its Products. This warranty is made to the original 

Purchaser only, is non-transferable and may only be modified or amended by a 

written instrument signed by a duly authorized officer of Picarro. Sub-systems 

manufactured by other firms, but integrated into Picarro Products, are covered by 

the original manufacturer’s warranty and Picarro makes no warranty, express or 

implied, regarding such sub-systems. Products or parts thereof which are replaced 

or repaired under this warranty are warranted only for the remaining, un-expired 

portion of the original warranty period applicable to the specific Product replaced or 

repaired. 

 

DISCLAIMER 

THE FOREGOING WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER 
WARRANTIES WHETHER WRITTEN, ORAL OR IMPLIED, AND SHALL BE 
THE PURCHASER’S SOLE REMEDY AND PICARRO’S SOLE LIABILITY IN 
CONTRACT OR OTHERWISE FOR THE PRODUCT. PICARRO EXPRESSLY 
DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. 

The Purchaser’s exclusive remedy with respect to any defective Product shall be to 

have Picarro repair or replace such defective Product or credit the Purchaser’s 

account, whichever Picarro may elect in its sole discretion. If it is found that any 

Product has been returned which is not defective, the Purchaser will be notified 

and such Product returned at the Purchaser’s expense. In addition, a charge for 

testing and examination may, at Picarro’s sole discretion, be made on any Product 

so returned. 

These remedies are available only if: i) Picarro is notified in writing by the 

Purchaser promptly upon discovery of a Product defect, and in any event within the 

warranty period; ii) Picarro’s examination of such Product discloses to Picarro’s 

satisfaction that such defects actually exist and the Product has not been repaired, 

worked on, altered by persons not authorized by Picarro, subject to misuse, 

negligence or accident, or connected, installed, used or adjusted otherwise than in 

accordance with the instructions furnished by Picarro. 
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The following warranty conditions shall apply to all Picarro, Inc. products unless 

amended by a written instrument signed by a duly authorized officer of Picarro: 

ADJUSTMENT – No electrical, mechanical or optical adjustments to the product(s) 

are permitted. 

PARTS AND LABOR - New or factory-built replacements for defective parts will be 

supplied for twelve (12) months from date of shipment of the product. Replacement 

parts are warranted for the remaining portion of the original warranty period. There 

will be no charge for repair of products under warranty where the repair work is 

done by Picarro, Inc.  

NOT COVERED BY THE WARRANTY – Damage to any optical surface from 

improper handling or cleaning procedures. This applies specifically to those items 

subjected to excess laser radiation, contaminated environments, extreme 

temperature or abrasive cleaning. Damage due to ESD, abuse, misuse, improper 

installation or application, alteration, accident, negligence in use, improper storage, 

transportation or handling. No warranty shall apply where the original equipment 

identifications have been removed, defaced, altered or where there is any 

evidence of alterations, adjustments, removal of protective outer enclosure, any 

attempt to repair the product by unauthorized personnel or with parts other than 

those provided by Picarro, Inc.  

DAMAGE IN SHIPMENT - Your analyzer should be inspected and tested as soon 

as it is received. The product is packaged for safe delivery. If the product is 

damaged in any way, you should immediately file a claim with the carrier or, if 

insured separately, with the insurance company. Picarro, Inc. will not be 

responsible for damage sustained in shipment. All Picarro products are F.O.B. 

origin, shipped from the Picarro factory or Picarro distributor. The price of all 

Products, unless otherwise specifically stated, is Ex- Works, Sunnyvale, CA as 

defined by Incoterms, 2001. The cost of normal packaging for shipment is included 

in the invoiced price. Where Buyer specifies special packaging, a charge will be 

made to cover any extra expense. 

CLAIMS ASSISTANCE - Call Picarro, Inc. Customer Service or your local 

distributor for assistance. Give our representative the full details of the problem. 

Helpful information or shipping instructions will be provided. If requested, estimates 

of the charges for non-warranty or other service work will be supplied before work 

begins. 

RETURN PROCEDURE - Customers must obtain a Return Merchandise 

Authorization Number from Picarro, Inc. prior to returning units. Products being 

returned for repair must be shipped in their original shipping cartons to avoid 

damage. 
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REMOTE DATA ACCESS 

A.1 Picarro Serial Communication 

The analyzer supports an RS-232 physical command interface, which can 

be used to control the instrument and to retrieve concentration data. Not all 

features of the instrument are available on the serial interface. For details 

on how to use the serial command interface, please see the Programming 

Guide (included in pdf format on the installation CD). This command set 

may also be used across a TCP/IP interface through an Ethernet 

connection. Please contact Picarro for further details. 

A.2 Remote Data Access 

Using the RemoteAccess.ini file, the analyzer can be configured to 

automatically: 

• Send data from the instrument to a list of e-mail accounts. 

• Measure the offset of the host computer system clock from a set of 
Internet time servers and (optionally) to resynchronize the clock 
based on this information. 

The Internet connection need not be permanent and may be a dial-up 

connection accessible via a user-supplied USB modem. The task of 

sending data and/or synchronizing the clock on the analyzer is performed 

using the C:\Picarro\G2000\HostExe\RemoteAccess.exe program. This 

program can be set up to run periodically using the Windows task 

scheduler at a user-configurable frequency. If a dial-up connection to the 

Internet is employed, it is used only on demand to minimize the connection 

time. 

Each time that the RemoteAccess.exe program runs, it appends 

information to a log file, which keeps a record of the results of the time 

synchronization and of the files sent by e-mail. The RemoteAccess.exe 

program is configurable by means of an initialization file, which includes 

information such as the login credentials for the dial-up connection, the e-

mail account and the list of time servers. 

The initialization file is: 

C:\Picarro\G2000\AppConfig\Config\UtilitiesRemoteAccess\RemoteAccess

.ini 
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and it should be placed in the same directory as the executable 

RemoteAccess.exe. The file has one required section named LOGGING 

and three optional sections named NTP, DIALUP, and EMAIL. The logging 

section has a single key Logfile whose value is the path to the log file. 

Once this log file exceeds 64K bytes in length, it is backed up, appending a 

numeric extension to the file name, and a new file is opened. A total of ten 

backup log files are kept. 

NTP 

The NTP section controls querying the Internet time servers using the 

SNTP protocol (RFC4330) and the resetting of the clock on the host 

computer. If the section is not present, time synchronization is not carried 

out. The keys Server1, Server2, etc., are used to specify the URLs of the 

time servers. If the UpdateClock key is set to “true,” the offset is applied to 

the host clock. Otherwise, the offset is recorded, but the host clock is not 

changed. 

Email 

The EMAIL section controls the sending of the data files as e-mail 

attachments. If the section is not present, e-mail messages are not sent. 

The key Directory specifies the directory that contains the data files. When 

the program is run, files in this directory are sent to the specified recipients 

and the files are deleted. To avoid problems with incomplete files, 

programs that place files into this directory should do so using an atomic 

operation, such as a rename. The Server key is set to the name of an 

RFC2821- compliant SMTP server that sends the e-mail messages. 

The FROM key is the e-mail address from which the messages are sent. 

Note that some SMTP servers check that the source is permitted to send 

email while others allow any name in this field. The collection of e-mail 

addresses to which copies of the e-mail is sent is specified by the keys 

To1, To2, etc. The Subject key is used to fill the subject field in the email 

header and may be set to any string. Depending on the SMTP server, it 

may be necessary to use authentication before e-mails can be sent, as 

described in RFC2554. If such authentication is not needed, the key 

UseAuthentication is set to false. If this key is set to true, two additional 

keys Username and Password must also be specified for the e-mail 

account. 
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Dial-up 

The DIALUP section is used if a dial-up connection to the Internet needs to 

be established when the program runs. If the section does not exist, a 

permanent connection is assumed to be available for carrying out the other 

tasks specified in the initialization file. The connection name key specifies 

the name of the dial-up connection to use, as listed under Network 

Connections in the Control Panel. The values of the keys Username, 

Password and Number are used to make the connection. 

Examples of “RemoteAccess.ini” File 

[LOGGING] Logfile=c:/temp/RemoteAccessLog 

[NTP] 

Server1=time-a.nist.gov  

Server2=time-b.nist.gov  

Server3=time-a.timefreq.bldrdoc.gov  

Server4=time-b.timefreq.bldrdoc.gov  

Server5=time-c.timefreq.bldrdoc.gov  

Server6=time.nist.gov 

Server7=time-nw.nist.gov  

UpdateClock=1 

[DIALUP] 

ConnectionName=Picarro Dialup  

Access Username=user 

Password=password  

Number=14085551212 

[EMAIL] 

Server=smtp.servername.org  

Directory=c:/picarro/mailbox  

From=instrument@picarro.com  

To1=recipient1@site1.com  

To2=recipient2@site2.com 

Subject=CRDS data from Silverstone instrument  

UseAuthentication=0 
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THE DATA FILE VIEWER 

B.1 Introduction 

The Picarro Data File Viewer software is located in the Picarro Utilities 

folder on the desktop. The software allows the user to graph and to 

conduct statistical analysis of the raw data. Additional functions include 

Allan Variance plot and quadratic or polynomial fittings.   

The Picarro Data File Viewer includes two main menus: File and New. 

Figure 72: 
File Menu 

 

 

Figure 73: 
New Menu  

 

B.2 The File Menu 

This section describes the functions available from the Data File Viewer File 

menu. 

Open H5 

File > Open H5 opens a Picarro data file (HDF5 format) for data analysis and 

visualization. After opening the data file, you can create a new time series 

plot. Refer to New Time Series Plot for more information. 
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Load Config 

File > Load Config loads a configuration file (ini format) to restore 

parameters of a workplace. Refer to Save Configuration for more information. 

Unpack Zip File 

Use File > Unpack Zip File to concatenate all H5 files inside the zip file into 

a single H5 file. Refer to Concatenate H5 Files for details. 

Concatenate H5 Files 

Use File > Concatenate H5 files to concatenate multiple files and zip 

archives of H5 files into a single H5 file. Navigate to the desired folder or use 

the Define date range button to specify a date range of files to concatenate. 

(See next section.) 

After selecting the path of the data files, Data File Viewer will automatically 

search an H5 file in the specified zip/folder and look for all available 

variables in the H5 file. The variables are then listed in the left panel, and 

users can use “>>” button to move variables to the right panel for 

concatenation. 

Figure 74: 
Select Variables 

Form  
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Define Date Range 

Data File Viewer can search data files within the desired date range and 

then concatenate such files into an H5 file. 

By default, TimeZone is set to your local time zone. However, if data were 

taken elsewhere, select the time zone where data were taken. 

Select File > Concatenate H5 files, then click Define date range to specify 

the desired date range. 

Figure 75: 
Defining Date 

Range  

 

Data files are saved in directory trees named by date and time option.  

Picarro software saves data in a directory tree that is named by the 

creation year, month, and day. (See example directory tree in the following 

image.) Select this option if the target folder has this file structure. This 

way, Data File Viewer will only search folders within the desired date 

range, which can substantially reduce processing time. 

Figure 76: 
File Structure of 

Data File 
Viewer  
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NOTE 

To save processing time, Data File Viewer does not open data files, 

but only determines data acquisition time based on the file name. 

 

 
CAUTION 

Do not define a time range for data files whose names have been 

changed. 

 

 
NOTE 

Data File Viewer does not concatenate data files exactly within the 

defined time range. This is because the time extracted from file 

name is different from the data acquisition time. To not miss data 

points, Data File Viewer expands the specified time range, so the 

resulting dataset normally has a wider time range than the user 

specification. 

Convert DAT to H5 

Select File > Convert DAT to H5 to convert a file in DAT format to HDF5 

format. These formats are described below: 

• DAT format: DAT files accepted by DatViewer store tabular data 
(numbers and text) in plain text. 

• Each line of the file is a data record. Each record consists of one or 
more fields separated by whitespaces. 

• The first line of data file indicates column names. 

• There must be a field “EPOCH_TIME” to store the acquisition epoch 
time (expressed as seconds since Jan 1, 1970) of the data. 
Otherwise, the first and second fields must be “DATE” and “TIME”. 
The “DATE” field must have the format “mm/dd/yyyy” or “yyyy-mm-
dd”, and the “TIME” field must have the format “HH:MM: SS(.sss)” 
where (.sss) is an optional fraction of seconds. 

• HDF5 format: HDF5 is a data model, library, and file format for 
storing and managing data. (See the HDF5 Home Page on the HDF 
Group Web site for more information.) When converting DAT to 
HDF5 format, Data File Viewer creates a table named “results” to 
the contained data. 

Convert H5 to DAT 

Select File > Convert H5 to DAT to convert a file in a HDF5 format to 

DAT. These formats are described in Convert DAT to H5. 
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NOTE 

Data File Viewer does not concatenate data files exactly within the 

defined time range. This is because the time extracted from file 

name is different from the data acquisition time. To not miss data 

points, Data File Viewer expands the specified time, column name 

“fineLaser-Current_1_controlOn” will be replaced with 

“fineLaserCurr_1_ctrlOn”. 

Interpolation 

Interpolation describes the method for constructing data points with a 

range of a discrete set of known data points. Select File > Interpolation to 

perform interpolation on a time grid with a constant interval. 

Block Average 

Select File > Block Average to divide a dataset into small blocks based on 

a user-defined block size. The average is calculated for data in each block, 

and the results are saved in a new H5 file. 

 

 
NOTE 

The specified block size must be greater than the average data 

interval. 

Because the data interval is normally not a constant (unless interpolation is 

performed), fluctuations in the data interval will affect block averaging if the 

block size is comparable to the average data interval. 
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B.3 New – Time Series Plot 

You can specify to include create time-series plots with one, two, or three 

frames. New plots display in the Time Series Viewer. 

Figure 77: 
Time Series 

Viewer  

 

The next section describes the options available on the Time Series Viewer 

menu bar. Refer to Time Series Viewer Canvas on page 96 for information 

the Time Series Viewer UI features and options. 

B.4 Time Series Viewer Menus 

The Time Series Viewer form includes the following menus: 

Figure 78: 
Time Series 

Viewer Menus  

 

Time Series Viewer File Menu 

Use the File menu to save a configuration or take a screenshot. 

Figure 79: 
Time Series 

Viewer – File 
Menu  
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Save Configuration 

Click File > Save Configuration to open the Feature Capture form. With 

this form, you can save figure properties, expressions, filters, and other 

settings to a configuration file so that it can be easily loaded in the future. 

Figure 80: 
Time Series 

Viewer – 
Feature Capture  

 

 

 
CAUTION 

If a feature is not captured, it will be omitted when the configuration 

file is loaded. 

Depending on the features captured, loading a configuration file can have 

different effects. For example: 

• If all features are captured, a saved workplace is reproduced. 

• If Data file is not captured, saved parameters will be applied to the 
data file in memory. 

• If Expression is not captured, plots will not be transformed. 

• If X (Y) range is not captured, figures will be auto-scaled on the x (y) 
axis. 

Take ScreenShot 

Use File > Take ScreenShot to take a screenshot of the Time Series 

Viewer and save it as a .png to a specified file. 

Time Series Viewer Analysis Menu 

Use the Analysis menu to calculate statistics, generate a histogram, and to 

plot correlations and Allan Standard deviations. 
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Figure 81: 
Time Series 

Viewer – 
Analysis Menu  

 

Statistics 

Use Analysis > Statistics to calculate mean, standard deviation and peak 

to peak for all plots in the current window. 

Histogram 

Use Analysis > Histogram to generate a histogram of data as shown 

below. 

Figure 82: 
Histogram 

Window  

 

• Red Line: A Gaussian function fitted to the histogram. Fitting results 
of μ and σ are shown in the top-left corner of the plot. 

• Bin: Specifies the number of intervals that the range of values is 
divided into. 
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• Normalized: When selected, the sum of the histograms is 
normalized to 1. 

• Save data: Saves histogram data to a CSV file. 

• Save image: Saves the histogram image as a JPEG/PNG/PDF file. 

Correlation Plot 

Use Analysis > Correlation Plot to plot Y-axis data in one frame versus 

that in the other. This can be used when two or more frames exist in the 

current Time Series Plot window. See Correlation/XY Plot on Page 98 for 

details. 

Allan Standard Deviation Plot 

Use Analysis > Allan Standard Deviation Plot to create an Allan 

Standard Deviation plot (versus a standard deviation plot) for data in the 

current window. See Allan Variance for more information. 

Time Series Viewer View Menu 

Use the View menu to view X-axis information in date-time, minute, or hour 

format. 

Figure 83: 
Time Series 

Viewer –  
View Menu  

 

 

 
NOTE 

When switching from DateTime to Minute or Hour, the X-axis data 

is subtracted from the earliest point shown in the panel and then 

converted to the desired unit.  

  

https://en.wikipedia.org/wiki/Allan_variance
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The Time Series Viewer Canvas 

The Time Series Viewer canvas is comprised of interactive graphs and a 

variety of configuration options. 

Figure 84: 
Time Series 

Viewer Canvas  

 

Mouse Options and Graph Transform 

The following mouse actions can be used in the canvas graphs: 

• Left click and drag: Zooms into the selected area of the plot. 

• Left click and drag with the SHIFT key down: Pans the plot. 

• Left click and drag with CTRL key down: Zooms out from the plot. 

• Left click and drag with ALT key down: Stretches the plot. 

• Right-click: Opens an additional menu. Refer to the next section. 

Right-click Menu 

Right-clicking on the canvas provides opens a pop-up menu. 

Figure 85: 
Canvas Right-

click Menu  

 

Export Image: Exports the current plot as a jpeg, png, or pdf file. 
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Export Data in Current View: Exports only date/time and the selected 

variable in the current view to an HDF5 or CSV file. 

Export All Data in Current Time Range: Exports all variable columns of 

the selected dataset in the current time range to an HDF5 file. Refer to 

Concatenate H5 Files on page 88 for more information. 

Edit Plot properties: Opens the Image Editor form, where the following 

options can be specified: 

• Title: Edits the title of the plot. 

• Line: Specifies the line pattern of the plot. If None is selected, the 
data points will be plotted without connecting lines. 

• Marker: Specifies the marker type to indicate data points. If None is 
selected, data points will not be shown. 

• Min and Max: Specifies the minimum and maximum of data range 
for the X-axis and the Y-axis. 

• x[0]: Sets the earliest time of the dataset as the minimum of the X-
axis. 

• Time zone: Sets the time zone for date/time variables. This defaults 
to the local time zone. 

• Label: Specify a label for the X-axis and the Y-axis. 
 

Figure 86: 
Image Editor 

Form  

 

 

• Statistics: Calculates the mean, standard deviation, and peak to 
peak for data in the current view. 
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Dataset Name and Var Name 

An HDF5 file can store one or more tables. Each of these tables is called a 

Dataset. A table can contain one or more columns. Each column is called a 

variable (Var). 

Use the Dataset name drop down to select the dataset that will be used for 

this time series graph. Use the Var name drop down to select the column 

in the dataset to use in the graph. 

Autoscale Y 

When the Autoscale Y option is selected, the Time Series Viewer will 

autoscale on the Y-axis to make sure that all data within the range of the X-

axis is displayed. 

Average 

If Block is selected, a block average is calculated when you click the Do 

average button is clicked. Otherwise, a moving average is calculated. 

For a block average, Size specifies block size in unit of a minute. For a 

moving average, Size specifies subset size in unit of data points. 

 

 
REMINDER 

Averaging is performed after the Filter and Expression are 

performed. 

Mean, Std Dev, and Peak to Peak 

The Mean, Std dev (Standard deviation) and Peak to peak fields provide 

all the statistical information of data in the current view. 

Correlation/XY Plot 

The Correlation/XY Plot window includes two menu items: File and 

Analysis. For details about the File menu, see Save Configuration on  

page 93. 

 
REMINDER 

The canvas in this plot is interactive. For details about the plot 

canvas, see The Time Series Viewer Canvas on Page 96. 
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Figure 87: 
Correlation/XY 

Plot 

 

Analysis Menu 

The Analysis Menu includes three options: Fitting, Integration, and 

Statistics. 

• Fitting allows you to specify one of four fitting methods to include in 
the Correlation/XY plot: 

i. Linear fit: Specifies to fit to linear function y = c1x + c0 

ii. Quadratic fit: Specifies to fit to quadratic function y = c2x2 + 
c1x + c0 

iii. Polynomial fit: Specifies to fit polynomial function of degree 
n: y = Σcnxn 

iv. Curve fit: Specifies to use non-linear least squares to fit an 
arbitrary function to data.  

 

Figure 88: 
Analysis  

Menu 
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• Integration calculates area under the curve using the composite 
trapezoidal rule. 

• Statistics calculates mean, standard deviation, and peak to peak 
for data in the current view.  

After applying any of the above Analysis options, the results, statistics, or 

fitting function with coefficients are displayed in the lower portion of the 

Correlation Plot window.  

Figure 89: 
Results of 
Quadratic 

Fitting 
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LIST OF PARAMETERS 

These parameters can be toggled on the GUI. See the section Setup Tool for how 

to access this stored information. 

Be aware that the parameters are alphabetized by parameters starting with capital 

letters first before parameters starting with lowercase letters. 

List of Parameters Unit Explanation 

CavityPressure Torr 
Reading of cavity pressure. Operating pressure 
is 75 Torr 

CavityTemp Celsius 
Average temperature reading of 4 thermistors 
along the cavity. Operating cavity temperature is 
very close to 40 Celsius 

ChillerTemp Celsius 
Temperature reading of liquid in the chiller. The 
chiller is used to remove heat from laser and 
keep laser baseplate temperature constant 

CoolBoxAuxTec digiU 
Digital reading of auxiliary CoolBox TEC current. 
Above 32000 means that TEC is heating; below 
32000 means that TEC is cooling 

CoolBoxHeatsink1Temp Celsius 
Temperature reading of the other TEC used to 
keep CoolBox temperature constant. Operating 
temperature is about 42 Celsius 

CoolBoxHeatsink2Temp Celcius 
Temperature reading of the other TEC used to 
keep CoolBox temperature constant. Operating 
temperature is about 42 Celsius 

CoolBoxPriTec Celsius 
Digital reading of CoolBox TEC current. Above 
32000 means that TEC is heating; below 32000 
means that TEC is cooling 

CoolBoxTec Celsius 
Digital reading of CoolBox TEC current. Above 
32000 means that TEC is heating; below 32000 
means that TEC is cooling 

DasTemp Celsius 
Temperature reading of Logic board. Usually 
close 7oC above ambient 

Etalon1 AU 
Mean digital readout of Etalon1 transmission 
over scan 

Etalon2 AU 
Mean digital readout of Etalon2 transmission 
over scan 

EtalonTemp Celsius 
Temperature of Etalon in the Wavelength 
monitor 

FRAC_DAYS_SINCE_JAN1 Days Time since January 1, 1970 

FRAC_HRS_SINCE_JAN1 Hours Time since January 1, 1970 

HotBoxHeater AU 
Digital reading of heater current. The heater is 
underneath the CoolBox. It is used to heat the 
CoolBox. For this unit, the heater is not used 
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List of Parameters Unit Explanation 

INST_STATUS Bit Bit mask for instrument Status, nominally 163 

InletValve AU 
Digital reading of Inlet Valve Voltage. Default 
setting is 50000 

JULIAN_DAYS Days Days since January 1, 1970 

Laser1Current Celsius Average laser current setpoint for entire scan 

Laser1Tec AU Average laser current for entire scan 

Laser1Temp Celsius 
Average temperature reading for laser for entire 
scan 

LaserBaseplateTec AU 
Current setpoint for the TEC controlling the 
Laser Baseplate 

LaserBaseplateTemp Celsius 
Temperature reading of Laser Baseplate. 
nominal baseplate temperature is set to 27 
Celsius 

MPVPosition AU Valve position for attached rotary valve 

N2O ppb N2O concentration 

N2O_100s ppb 
Running average of N2O concentration for 
previous 100 seconds 

OutletValve AU Outet Valve voltage  

P2Temp Celsius 
Temperature reading of one thermistor along the 
cavity. This thermistor is located close to front 
mirrors 

P3Temp Celsius 
Temperature reading of second thermistor along 
the cavity. This thermistor is located close to 
Wavelength Monitor. 

P4Temp Celsius 
Temperature reading of third thermistor along 
the cavity. This thermistor is located close to 
Ringdown Detector 

P9Temp Celsius 
Temperature reading of fourth thermistor along 
the cavity. This thermistor is located close to 
rear mirror 

Ratio1 AU 
Average Ratio of Etalon 1 to Reference 1 over a 
scan 

Ratio2 AU 
Average Ratio of Etalon 2 to Reference 2 over a 
scan 

RecalibrateFlag  

Number of times PZT has jumped causing a shift 
in the offset of isotopic calibration. Recalibrate 
instrument after incremented. Analyzer always 
restarts with 0. 



 

G5131-i User Manual P/N 40-0008 Rev. D 103 

List of Parameters Unit Explanation 

Reference1 AU 
Optical signal of Reference 1 in the wavelength 
monitor 

Reference2 AU 
Optical signal of Reference 2 in the wavelength 
monitor 

ValveMask AU Binary addition of current valve state 

WlmTemp Celsius Controlled Temperature of Wavelength Monitor 

adjust1 cm-1 

The amount of Wavelength Monitor (WLM) offset 
change for virtual laser 1 after each spectral 
scan 

adjust2 cm-1 

The amount of Wavelength Monitor (WLM) offset 
change for virtual laser 2 after each spectral 
scan 

base1a ppb/cm Baseline level for N2O peak fit for virtual laser 1 

base1b ppb/cm Baseline level for N2O peak fit for virtual laser 2 

co2_corr ppm CO2 concentration after corrections  

co2_raw ppm Raw CO2 concentration from spline fit 

d15N permil Isotopic ratio/Delta for N isotopes of N2O 

d15Nalpha permil Isotopic ratio/Delta for alpha isotope of N2O 

d15Nalpha_100s permil 
Running average of Delta for N2O alpha isotope 
of last 100 seconds 

d15Nbeta permil Isotopic ratio/Delta for beta isotope of N2O 

d15Nbeta_100s permil 
Running average of Delta for N2O beta isotope 
of last 100 seconds 

d18O permil Isotopic ratio/Delta for 18O isotope of N2O 

d18O_100s permil 
Running average of Delta for N2O 18O isotope 
of last 100 seconds 

dm_latency seconds Datamanager processing duration 

fitBackground AU Digital background of ringdown signal 

fit_time Seconds Duration of time to fit data 
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List of Parameters Unit Explanation 

fsr_base1 ppb/cm Baseline loss level for 14N2O final peak fit 

fsr_base4 ppb/cm Baseline loss level for alpha isotopomer 

fsr_base5 ppb/cm Baseline loss level for beta isotopomer 

fsr_base6 ppb/cm Baseline loss level for O18 isotopologue 

fsr_peak1 ppb/cm Peak loss for 14N2O absorption feature 

fsr_peak1_spec ppb/cm Corrected peak loss for 14N2O 

fsr_peak4 ppb/cm 
Raw peak corresponding to Alpha isotope of 
N2O 

fsr_peak4_spec ppb/cm 
Peak corresponding to Alpha isotope of N2O 
with corrections 

fsr_peak5 ppb/cm Raw peak corresponding to Beta isotope of N2O 

fsr_peak5_spec ppb/cm 
Peak corresponding to Beta isotope of N2O with 
corrections 

fsr_peak6 ppb/cm 
Raw peak corresponding to oxygen isotope of 
N2O 

fsr_peak6_spec ppb/cm 
Peak corresponding to oxygen isotope of N2O 
with corrections 

fsr_residuals1 ppb/cm RMS loss residual of N2O fit 

fsr_residualsN ppb/cm RMS loss residual of virtual laser 1 scan 

fsr_residualsO ppb/cm RMS loss residual of virtual laser 2 scan 

fsr_shiftN cm-1 

The amount of Wavelength Monitor (WLM) offset 
change for virtual laser 1 after each spectral 
scan 

fsr_shiftO cm-1 
The amount of Wavelength Monitor (WLM) offset 
change for virtual laser 2 after each spectral 
scan 

fsr_str1 ppb Fitted strength of 14N2O absorption feature 

fsr_str4 ppb Fitted strength of alpha 15N2O absorption feature 

fsr_str5 ppb Fitted strength of alpha 15N2O absorption feature 
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List of Parameters Unit Explanation 

fsr_str6 ppb 
Fitted strength of 18O isotopologue N2O 
absorption feature 

fsr_y1 AU Fitted width of 14N2O absorption feature 

interval seconds time period of each measurement 

max_fitter_latency seconds Fitter processing duration 

n2o_conc_raw ppb Raw N2O concentration 

ngroups1 AU 
Number of ringdown clusters in virtual laser 1 
scan 

ngroups2 AU 
Number of ringdown clusters in virtual laser 2 
scan 

numpoints number Number of total RingDowns per spectral scan 

peak1a ppb/cm Peak loss for 14N2O absorption feature 

peak1b ppb/cm Peak loss for 14N2O absorption feature 

pzt1_adjust AU 
Amount PZT voltage is off in order to center 
peak 

pzt1_delta AU 
Amount PZT voltage has changed from precious 
scan 

pzt1_offset AU PZT voltage setpoint for virtual laser 1 

pzt2_adjust AU 
Amount PZT voltage is off in order to center 
peak 

pzt2_delta AU 
Amount PZT voltage has changed from precious 
scan 

pzt2_offset AU PZT voltage setpoint for virtual laser 1 

pzt_per_fsr AU 
Amount PZT must move to jump to next FSR 
point. The distance moved when Recalibrate flag 
is incremented 

shift1 cm-1 
The amount of Wavelength Monitor (WLM) offset 
change for virtual laser 1 after each spectral 
scan 

shift2 cm-1 

The amount of Wavelength Monitor (WLM) offset 
change for virtual laser 2 after each spectral 
scan 
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List of Parameters Unit Explanation 

spect_duration seconds Time to collect spectral scan 

spect_latency seconds Time to process spectrum 

str1a ppb 
Fitted strength of 14N2O absorption feature for 
virtual laser 1 

str1b ppb 
Fitted strength of 14N2O absorption feature for 
virtual laser 2 

timestamp Seconds Time in seconds since 0 

vy1a AU 
Fitted width of 14N2O absorption feature for 
virtual laser 1 

vy1b AU 
Fitted width of 14N2O absorption feature for 
virtual laser 2 

wlm1_offset cm-1 Current frequency offset of for virtual laser 1 

wlm2_offset cm-1 Current frequency offset of for virtual laser 2 
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RECALIBRATION FLAG  

The Recalibration Flag is data column in the Datalogs, as well as a warning 

message in the status log window of the GUI that informs the user that the 

calibration has changed due to a discontinuous jump in the way the instrument 

tunes. It was put in place along with a new method of tuning called Laser Current 

Tuning (LCT) that maintains the PZT at a constant position. Over time the PZT 

voltage changes slowly to maintain ringdowns at specific desired frequencies; 

however, if the voltage ever reaches an extremum (about 57000 or 12000), the 

PZT discontinuously jumps to its next resonance position which is exactly one half 

wavelength of light away. This jump in position can cause a change in the 

calibration offsets for isotopes by as much as 6‰. These events are expected to 

occur infrequently, once every 4-8 weeks. Because there are specific conditions in 

which this event occurs, the user can monitor the PZT voltage while in use to 

estimate the next occurrence. (i.e. “pzt1_offset” or “pzt2_offset” near 12000 or 

57000). 

The events associated with the jump in PZT voltages  are tracked enumerated in a 

Recalibration_flag data column located in the user data file. A warning message on 

the instrument GUI is also displayed to alert the user what time this occurred. For 

diagnostic purposes this message is also logged in the Event Logs, which are 

found in the C:\Picarro\G2000]Log\Archive\EventLogs folder.  A picture of the 

event message is shown below. 

Figure 90: 
Event Log 

 

When this happens to an analyzer, it is recommended that the isotope 

measurements be recalibrated before any more data is to be taken. If the analyzer 

is kept measuring after a calibration is done, the Recalibration_flag will be 

maintained at 1 until this event occurs again, in which it will be incremented to 2. 

Whenever the instrument is restarted this flag will be initialized to 0. This means 

that there is no memory of the last time this event occurred. It is solely the 

responsibility of the user to maintain proper calibration of the instrument for 

measurements, specifically when these events occur. 

For more information, contact support@picarro.com 
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ANALOG SIGNAL OUTPUT 

E.1 Overview 

This section is provided if the G5131-i is configured with an optional 

Electrical Interface Card (EIC). It provides 4 analog signals for monitoring 

various measurement results and analyzer parameters. 

Two circular connectors, on the back panel of the analyzer are available for 

analog output. The pinout for each connector is listed in the table below.  

Figure 90 shows the analog channel connectors on the back of the 

analyzer. 

Figure 91: 
Analog 

Channel 
Connectors 

 

Two external cables (for the analog channel connectors) are provided with 

the analyzer. The mating connector is part number HR25-7TP-8P(72) 

E.2 Analog Signal Pin Mapping 

The table below lists the analog pinouts and Figure 91 shows the analog 

pinout map. 

Pin Function  Pin Function 

1 GND 0  1 GND 4 

2 Channel 0  2 Channel 4 

3 GND 1  3 GND 5 

4 Channel 1  4 Channel 5 

5 GND 2  5 GND 6 

6 Channel 2  6 Channel 6 

7 GND 3  7 GND 7 

8 Channel 3  8 Channel 7 
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Figure 92: 
Analog Pin 

Map 
 

E.3 Configuration 

The default configuration is set at the factory and is listed in the table 

below. It can be modified by editing the electricalInterface.ini file located in 

the C:\Picarro\G2000\AppConfig\ElectricalInterface directory. 

E.4 Analog Output Configuration 

+1 volt indicates 0 in all cases: Each channel has a +1 volt offset. Treat 

<=0 volts as an error. This helps prevent reading the wrong values 

because of improper wiring (ground loops).  

Example for Channel 0: 1V = 20ppb with a 1V offset. 9v x 200 ppb/V = 180 

ppb = 1.8 ppm. 

Analog Configuration Master Table 

Channel Parameter Output Scale 
(<1V indicates 
error) 

Conversion 
All channels 
have a +1V 
offset 
(+1V=0) 

Indicating 
Range 
1V to 10V or 0 
to 90 ppb 

0  0-10V 10 ppb/V 0 to 90 ppb 

1  0-10V 100 ppb/V 0 to 0.9 ppm 

2  0-10V 2%/V 0 to 18% 

3 DAS temp 0-10V 10o C/V 0 to 90 o C 

4 None NA NA NA 

5 None NA NA NA 

6 None NA NA NA 

7 None NA NA NA 
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PACKING AND SHIPPING 

The following describes how to prepare the G5131-i for shipment. Shown here is a 

step by step procedure which, if followed correctly, will help ensure the safe 

delivery of the system. Please follow the instructions carefully. 

1. Ensure the analyzer has been fully powered down following the 
previous instructions. 

2. Disconnect all electronic cables and the vacuum line from the rear 
of the analyzer. 

Figure 93: 
Disconnect  

 

3. Place the two power lines, two electronic cables and one vacuum 
line into a plastic bag. 

4. Remove the lid of the PPU by removing the six screws which are 
used to attach the lid of the PPU to the main PPU assembly. These 
screws are located on upper sides of the PPU. There are three 
screws on each side. 

Figure 94: 
Remove Six 
Screws from 

Side Panel 
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5. The next step is to secure the pump in the PPU for shipping by 
attaching the two screws* through the bottom of the PPU to the 
pump mounting bracket. 

Figure 95: 
Secure Pump 

 

6. Press the pump towards the PPU base (see figure below) and insert 
the two screws into the holes at the bottom of the PPU and tighten 
two screws. This step is easier with the PPU on its side. 

Figure 96: 
Securing Pump 

for Shipment 

 

7. Secure the pump by rotating the black cover plate so that the screw 
holes in the black plate line up with the through holes in the bottle of 
the PPU cover and tightening the screws. The proper orientation is 
shown below. 

*These two screws are 

removed from the base of the 

PPU during the unpacking 

process and must be saved 

for repacking. 

Press on pump to 

install securing 

screws on bottom 

of housing 
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Figure 97: 
Securing Pump 

Shipment 
Screws 

 

8. Place the lid back on top of the PPU, close the lid of the PPU and 
re-attach the six screws which are used to secure the lid of the PPU 
to the main PPU assembly. Place the PPU in its plastic bag with two 
desiccant pouches as shown in the two figures below. Ensure that 
the bag remain closed by sealing with 2” wide packing tape. 

Figure 98: 
Bagging the 

PPU 

 

9. Place the analyzer in its plastic bag with two desiccant pouches as 
shown below. Again, ensure that the bag remains closed by sealing 
with 2” wide packing tape. 
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Figure 99: 
Bagging the 

Analyzer 

 

10. Place Analyzer into the side of the wood shipping crate containing 
the saw toothed shaped packing foam. Placing the analyzer in the 
correct area is extremely important. Make sure analyzer is placed in 
this area such that it fits completely inside the packing foam (see 
figure below). 

Figure 100: 
Unit Packing 

Locations 

 
 

 

  

Analyzer 

Location 

Pump 

Location 
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12. Place PPU into the other side of the wood shipping crate. Placing 
the PPU and analyzer in their correct respective areas is extremely 
important. Make sure PPU is placed in this area such that it fits 
completely inside the packing foam (see figures below). Once the 
PPU is in position, place the remaining small pieces of packing 
material at the back of the PPU as shown in the figures below. 

Figure 101: 
Pack 

Remaining 
Foam Around 

PPU 

 

13. Place the plastic bag containing the two power lines, two electronic 
cables and one vacuum line on top of the PPU as shown in the 
figure below. 

Figure 102: 
Add Cable Bag 
and Foam Top 

Piece 
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15. Place the large foam insulation piece on top of the analyzer and 
PPU as shown in the figure below. The plastic bag containing the 
two power lines, two electronic cables and one vacuum line will sit in 
the rectangular hole in the foam lid. 

Figure 103: 
Ready for Top 

Cover 

 

16. Place the lid on the wooden crate as shown in the figure below. The 
metal clamps shown in the figure are used to secure the lid to the 
wooden crate. 

Figure 104: 
Ready For 

Clamps 
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18. Secure the lid by pressing down on the clamps as shown in the 
figure below. There should be eight clamps in all. 

Figure 105: 
Attaching 

Clamps 

 

19. When completely assembled, the packing crate should look like the 
system shown in the figure below. 

Figure 106: 
Ready to Ship 

 

20. To finish, remove any old shipping labels from the crate and attach 
new labels as appropriate. 


	1. INTRODUCTION TO TECHNOLOGY
	1.1 Cavity Ring-Down Spectroscopy (CRDS)
	1.2  Relating ring-down time to absorption intensity
	1.3  Converting absorption intensity to concentration
	1.4 Spectral precision and high sensitivity measurements

	2. CONVENTIONS
	3. ACRONYMS
	4. SAFETY
	4.1 General Safety
	CDRH Certification
	CE Certification

	4.2 Laser Safety

	5. UNPACKING THE ANALYZER
	5.1 Inspect the Shipping Boxes
	5.2 Unpack the Shipping Crate
	Analyzer, Pump, and Connection Components
	Unpacking the Pump Unit


	6. ANALYZER OVERVIEW
	6.1 Intended Use
	6.2 External Vacuum Pump
	6.3 Analyzer Specifications
	6.4 Analyzer Operation Flow Diagram

	7. INSTALLATION
	7.1 Analyzer and Vacuum Positioning
	7.2 Connections
	7.3 Connecting to the Analyzer Inlet
	Making a New Connection:
	Replacing a Connection

	7.4 Water Removal from the Gas Stream

	8. ANALYZER BASIC OPERATION
	8.1 Startup Procedure
	8.2 Desktop Icons and Folders
	8.3 Shutdown Procedure
	8.4 Recovery from Electrical Power Outage

	9. LIST OF GUI FUNCTIONS
	9.1 GUI Overview
	9.2 Settings, Tools, and Help Menus
	Settings Menu
	Tools Menu
	Help Menu

	9.3 Alarms Panel
	9.4 Instrument status
	9.5 Data Log Filename and Path
	9.6 Data Window
	Data Source and Data Key Pull Down Menus
	Precision Pulldown Menu
	Data Buffer Level Meter
	Reset Data Buffer Button
	Graph Zooming
	Digital Readouts
	Start / Stop Data Log Button

	9.7
	9.8 Status Log Window

	10. MAINTENANCE
	10.1 Cleaning
	10.2 Fuse Replacement Procedure
	10.3 Particulate Filter Replacement
	Symptoms of a Clogged Filter
	Solutions
	Tools Required
	Particulate Filter Removal

	10.4 Laser Chiller Service
	Buffer Tank Initial Coolant Fill
	Refilling the Chiller


	11. TROUBLESHOOTING
	11.1 Power LED on Analyzer Does Not Illuminate
	11.2 GUI Does Not Display at Start-Up
	11.3 Cavity Pressure Cannot be Adjusted for Concentration Measurements
	11.4 User Interface Program Does Not Update Graphs as Data is Collected
	Shut Down the Computer


	12. FILE MANAGEMENT
	12.1 File Archival and Automatic Deletion of Old Files
	12.2 Setup Tool
	Data Logger
	Serial/Socket Port Manager
	Data Delivery Setup
	Editing Main GUI Properties
	Specifying Digital Data Output for Command Interface
	Specifying Digital Data Output for Data Streaming
	Customizing Analog Output Channels
	Electrical Interface


	13. CALIBRATION
	13.1 Slope and Offset
	13.2 Calibration Methodology
	Calibration Setup
	Measurement Time for Each Standard
	Measuring Multiple Gas Standards
	Calibration Data Processing
	Entering the Calibration Setting

	13.3 Calibration Software Utility tools
	Data Recal
	Graphical User Interface (GUI)


	14. STATUS LOG MESSAGES
	14.1 Normal Startup Messages
	Temperature Locked: WB
	Temperature Locked: HB
	Preparing to Measure
	Pressure Stabilizing/Locked
	Measuring


	15. CONTROLLING EXTERNAL VALVES
	15.1 Display the Show/Hide Valve Sequencer GUI
	15.2 The External Valve Sequencer Window
	15.3 File Menu
	Load a Valve Sequence File
	Save a Valve Sequence File

	15.4 Action Menu
	Start Sequencer
	Go to First Step
	Reset All Valves
	Hide Sequencer Interface

	15.5 Current Status Fields
	Current Step #
	Remaining Time (min)
	Current Valve State
	Current Valve Code
	Current Rot. Valve Code

	15.6 Step Definition Fields
	Step #
	Duration (min)
	Rot. Valve Code

	15.7 Bottom Panel
	Total Steps
	Run Step #
	Apply
	Run Next Step
	Start Date
	Start Time
	Schedule Sequence

	15.8 Set Up a Test Sequence Using the Valve Sequencer Window
	15.9 Load and Run a Saved Sequence

	16. LIMITED WARRANTY
	APPENDIX A –  REMOTE DATA ACCESS
	A.1 Picarro Serial Communication
	A.2 Remote Data Access
	NTP
	Email
	Dial-up
	Examples of “RemoteAccess.ini” File


	APPENDIX B –  THE DATA FILE VIEWER
	B.1 Introduction
	B.2 The File Menu
	Open H5
	Load Config
	Unpack Zip File
	Concatenate H5 Files
	Define Date Range
	Convert DAT to H5
	Convert H5 to DAT
	Interpolation
	Block Average

	B.3 New – Time Series Plot
	B.4 Time Series Viewer Menus
	Time Series Viewer File Menu
	Save Configuration
	Take ScreenShot
	Time Series Viewer Analysis Menu
	Statistics
	Histogram
	Correlation Plot
	Allan Standard Deviation Plot
	Time Series Viewer View Menu
	The Time Series Viewer Canvas
	Mouse Options and Graph Transform
	Right-click Menu
	Dataset Name and Var Name
	Autoscale Y
	Average
	Mean, Std Dev, and Peak to Peak
	Correlation/XY Plot
	Analysis Menu


	APPENDIX C –  LIST OF PARAMETERS
	APPENDIX D –  RECALIBRATION FLAG
	APPENDIX E –  ANALOG SIGNAL OUTPUT
	E.1 Overview
	E.2 Analog Signal Pin Mapping
	E.3 Configuration
	E.4 Analog Output Configuration

	APPENDIX F –  PACKING AND SHIPPING

